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About Installing and ConfiguringVMware Identity Manager
 Installing and Configuring VMware Identity Manager provides information about the installation andconfiguration process for the VMware Identity Manager appliance. When the installation is finished, youcan use the administration console to entitle users to managed multi-device access to your organization'sapplications, including Windows applications, software as a service (SaaS) applications, and View orHorizon desktops. The guide also explains how to configure your deployment for high availability.
 Intended AudienceThis information is intended for administrators of VMware Identity Manager. The information is written forexperienced Windows and Linux system administrators who are familiar with VMware technologies,particularly vCenter™, ESX™, vSphere®, and View™, networking concepts, Active Directory servers,databases, backup and restore procedures, Simple Mail Transfer Protocol (SMTP), and NTP servers. SUSELinux 11 is the underlying operating system for the virtual appliance. Knowledge of other technologies,such as VMware ThinApp® and RSA SecurID is helpful if you plan to implement those features.
 VMware, Inc. 7
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Preparing to InstallVMware Identity Manager 1
 The tasks to deploy and set up VMware Identity Manager require that you complete the prerequisites,deploy the VMware Identity Manager OVA file and complete the setup from the VMware Identity ManagerSetup wizard.
 VMware, Inc. 9
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Figure 1‑1. VMware Identity Manager Architecture Diagram for Typical Deployments
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 Note If you plan to enable certificate or smart card-based authentication, use the SSL pass-through settingat the load balancer, instead of the terminate SSL setting. This configuration ensures that the SSL handshakeis between the connector, a component of VMware Identity Manager, and the client.
 Note Depending on the location of the AirWatch deployment, the AirWatch REST APIs could be in thecloud or on premises.
 This chapter includes the following topics:
 n “System and Network Configuration Requirements,” on page 11
 n “Preparing to Deploy VMware Identity Manager,” on page 14
 n “Customer Experience Improvement Program,” on page 17
 Installing and Configuring VMware Identity Manager
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System and Network Configuration RequirementsConsider your entire deployment, including how you integrate resources, when you make decisions abouthardware, resources, and network requirements.
 Supported vSphere and ESX VersionsThe following versions of vSphere and ESX server are supported:
 n 5.0 U2 and later
 n 5.1 and later
 n 5.5 and later
 n 6.0 and later
 Note You must turn on time sync at the ESX host level using an NTP server. Otherwise, a time drift occursbetween the virtual appliances.
 If you deploy multiple virtual appliances on different hosts, consider disabling the Sync to Host option fortime synchronization and configuring the NTP server in each virtual appliance directly to ensure that thereis no time drift between the virtual appliances.
 Hardware RequirementsEnsure that you meet the requirements for the number of VMware Identity Manager virtual appliances andthe resources allocated to each appliance.
 Number of Users Up to 1,000 1,000-10,000 10,000-25,000 25,000-50,000 50,000-100,000
 Number ofVMware IdentityManager servers
 1 server 3 load-balancedservers
 3 load-balancedservers
 3 load-balancedservers
 3 load-balancedservers
 CPU (per server) 2 CPU 2 CPU 4 CPU 8 CPU 8 CPU
 RAM (per server) 6 GB 6 GB 8 GB 16 GB 32 GB
 Disk space (perserver)
 60 GB 100 GB 100 GB 100 GB 100 GB
 If you install additional, external connector virtual appliances, ensure that you meet the followingrequirements.
 Number of Users Up to 1,000 1,000-10,000 10,000-25,000 25,000-50,000 50,000-100,1000
 Number ofconnector servers
 1 server 2 load-balancedservers
 2 load-balancedservers
 2 load-balancedservers
 2 load-balancedservers
 CPU (per server) 2 CPU 4 CPU 4 CPU 4 CPU 4 CPU
 RAM (per server) 6 GB 6 GB 8 GB 16 GB 16 GB
 Disk space (perserver)
 60 GB 60 GB 60 GB 60 GB 60 GB
 Database RequirementsSet up VMware Identity Manager with an external database to store and organize server data. An internalPostgreSQL database is embedded in the virtual appliance but it is not recommended for use withproduction deployments.
 Chapter 1 Preparing to Install VMware Identity Manager
 VMware, Inc. 11
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For information about the database versions and service pack configurations supported, see the VMwareProduct Interoperability Matrices at https://www.vmware.com/resources/compatibility/sim/interop_matrix.php.
 The following requirements apply to an external SQL Server database.
 Number of Users Up to 1,000 1,000-10,000 10,000-25,000 25,000-50,000 50,000-100,000
 CPU 2 CPU 2 CPU 4 CPU 8 CPU 8 CPU
 RAM 4 GB 4 GB 8 GB 16 GB 32 GB
 Disk space 50 GB 50 GB 50 GB 100 GB 100 GB
 Network Configuration Requirements
 Component Minimum Requirement
 DNS record and IP address IP address and DNS record
 Firewall port Ensure that the inbound firewall port 443 is open for users outside the network tothe VMware Identity Manager instance or the load balancer.
 Reverse Proxy Deploy a reverse proxy such as F5 Access Policy Manager in the DMZ to allowusers to securely access the VMware Identity Manager user portal remotely.
 Port RequirementsPorts used in the server configuration are described here. Your deployment might include only a subset ofthese ports. Here are two potential scenarios:
 n To sync users and groups from Active Directory, VMware Identity Manager must connect to ActiveDirectory.
 n To sync with ThinApp, the VMware Identity Manager must join the Active Directory domain andconnect to the ThinApp Repository share.
 Port Portal Source Target Description
 443 HTTPS Load Balancer VMware Identity Manager virtualappliance
 443 HTTPS VMware Identity Managervirtual appliance
 VMware Identity Manager virtualappliance
 443 HTTPS Browsers VMware Identity Manager virtualappliance
 443 HTTPS VMware Identity Managervirtual appliance
 vapp-updates.vmware.com Access to theupgrade server
 8443 HTTPS Browsers VMware Identity Manager virtualappliance
 Administrator Port
 25 SMTP VMware Identity Managervirtual appliance
 SMTP Port to relayoutbound mail
 38963632683269
 LDAPLDAPSMSFT-GCMSFT-GC-SSL
 VMware Identity Managervirtual appliance
 Active Directory Default values areshown. These portsare configurable.
 445 TCP VMware Identity Managervirtual appliance
 VMware ThinApp repository Access to theThinApp repository
 Installing and Configuring VMware Identity Manager
 12 VMware, Inc.
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Port Portal Source Target Description
 5500 UDP VMware Identity Managervirtual appliance
 RSA SecurID system Default value isshown. This port isconfigurable.
 53 TCP/UDP VMware Identity Managervirtual appliance
 DNS server Every virtualappliance must haveaccess to the DNSserver on port 53and allow incomingSSH traffic on port22.
 88, 464, 135 TCP/UDP VMware Identity Managervirtual appliance
 Domain controller
 9300–9400 TCP VMware Identity Managervirtual appliance
 VMware Identity Manager virtualappliance
 Audit needs
 54328 UDP
 1433, 5432,1521
 TCP VMware Identity Managervirtual appliance
 Database Microsoft SQLdefault port is 1433The Oracle defaultport is 1521
 443 VMware Identity Managervirtual appliance
 View server Access to Viewserver
 80, 443 TCP VMware Identity Managervirtual appliance
 Citrix Integration Broker server Connection to theCitrix IntegrationBroker. Port optiondepends on whethera certificate isinstalled on theIntegration Brokerserver
 443 HTTPS VMware Identity Managervirtual appliance
 AirWatch REST API For devicecompliance checkingand for the AirWatchCloud Connectorpasswordauthenticationmethod, if that isused.
 88 TCP/UDP iOS mobile device VMware Identity Manager virtualappliance
 Port used forKerberos traffic fromiOS device to thebuilt-in KDC.
 5262 TCP Android mobile device AirWatch HTTPS proxy service AirWatch Tunnelclient routes trafficto the HTTPS proxyfor Android devices.
 Active DirectoryVMware Identity Manager supports Active Directory on Windows 2008, 2008 R2, 2012, and 2012 R2, with aDomain functional level and Forest functional level of Windows 2003 and later.
 Chapter 1 Preparing to Install VMware Identity Manager
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Supported Web Browsers to Access the Administration ConsoleThe VMware Identity Manager administration console is a Web-based application you use to manage yourtenant. You can access the administration console from the following browsers.
 n Internet Explorer 11 for Windows systems
 n Google Chrome 42.0 or later for Windows and Mac systems
 n Mozilla Firefox 40 or later for Windows and Mac systems
 n Safari 6.2.8 and later for Mac systems
 Note In Internet Explorer 11, JavaScript must be enabled and cookies allowed to authenticate throughVMware Identity Manager.
 Supported Browsers to Access the Workspace ONE PortalEnd users can access the Workspace ONE portal from the following browsers.
 n Mozilla Firefox (latest)
 n Google Chrome (latest)
 n Safari (latest)
 n Internet Explorer 11
 n Microsoft Edge browser
 n Native browser and Google Chrome on Android devices
 n Safari on iOS devices
 Note In Internet Explorer 11, JavaScript must be enabled and cookies allowed to authenticate throughVMware Identity Manager.
 Preparing to Deploy VMware Identity ManagerBefore you deploy VMware Identity Manager, you must prepare your environment. This preparationincludes downloading the VMware Identity Manager OVA file, creating DNS records, and obtaining IPaddresses.
 Prerequisites
 Before you begin to install VMware Identity Manager complete the prerequisite tasks.
 n You need one or more ESX servers to deploy the VMware Identity Manager virtual appliance.
 Note For information about supported vSphere and ESX server versions, see the VMware ProductInteroperability Matrixes at http://www.vmware.com/resources/compatibility/sim/interop_matrix.php.
 n VMware vSphere Client or vSphere Web Client is required to deploy the OVA file and access thedeployed virtual appliance remotely to configure networking.
 n Download the VMware Identity Manager OVA file from the VMware Web site.
 Installing and Configuring VMware Identity Manager
 14 VMware, Inc.
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Create DNS Records and IP AddressesA DNS entry and a static IP address must be available for the VMware Identity Manager virtual appliance.Because each company administers their IP addresses and DNS records differently, before you begin yourinstallation, request the DNS record and IP addresses to use.
 Configuring reverse lookup is optional. When you implement reverse lookup, you must define a PTR recordon the DNS server so the virtual appliance uses the correct network configuration.
 You can use the following sample list of DNS records when you talk to your network administrator. Replacethe sample information with information from your environment. This example shows forward DNSrecords and IP addresses.
 Table 1‑1. Examples of Forward DNS Records and IP Addresses
 Domain Name Resource Type IP Address
 myidentitymanager.company.com A 10.28.128.3
 This example shows reverse DNS records and IP addresses.
 Table 1‑2. Examples of Reverse DNS Records and IP Addresses
 IP Address Resource Type Host Name
 10.28.128.3 PTR myidentitymanager.company.com
 After you complete the DNS configuration, verify that the reverse DNS lookup is properly configured. Forexample, the virtual appliance command host IPaddress must resolve to the DNS name lookup.
 Using a Unix/Linux-based DNS ServerIf you are using a Unix or Linux-based DNS server and plan to join VMware Identity Manager to the ActiveDirectory domain, make sure that the appropriate service (SRV) resource records are created for each ActiveDirectory domain controller.
 Note If you have a load balancer with a Virtual IP address (VIP) in front of the DNS servers, note thatVMware Identity Manager does not support using a VIP. You can specify multiple DNS servers separated bya comma.
 Database Options with VMware Identity ManagerSet up VMware Identity Manager with an external database to store and organize server data. An internalPostgreSQL database is embedded in the appliance but it is not recommended for use with productiondeployments.
 To use an external database, your database administrator must prepare an empty external database andschema before connecting to the external database in the Setup wizard. Licensed users can use a MicrosoftSQL database server or Oracle database server to set up a high availability external database environment.See “Connecting to the Database,” on page 32.
 Chapter 1 Preparing to Install VMware Identity Manager
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Connecting to Your Enterprise DirectoryVMware Identity Manager uses your enterprise directory infrastructure for user authentication andmanagement. You can integrate VMware Identity Manager with an Active Directory environment thatconsists of a single Active Directory domain, multiple domains in a single Active Directory forest, ormultiple domains across multiple Active Directory forests. You can also integrate VMware Identity Managerwith an LDAP directory. To sync users and groups, the VMware Identity Manager virtual appliance mustconnect to the directory.
 Your directory must be accessible in the same LAN network as the VMware Identity Manager virtualappliance.
 See Chapter 4, “Integrating with Your Enterprise Directory,” on page 43 for more information.
 Deployment ChecklistsYou can use the deployment checklist to gather the necessary information to install theVMware Identity Manager virtual appliance.
 Information for Fully Qualified Domain NameTable 1‑3. Fully Qualified Domain Name (FQDN) Information Checklist
 Information to Gather List the Information
 VMware Identity Manager FQDN
 Network Information for VMware Identity Manager Virtual ApplianceTable 1‑4. Network Information Checklist
 Information to Gather List the Information
 IP address You must use a static IP address and it must have a PTRand an A record defined in the DNS.
 DNS name for this virtual appliance
 Default Gateway address
 Netmask or prefix
 Directory InformationVMware Identity Manager supports integrating with Active Directory or LDAP directory environments.
 Table 1‑5. Active Directory Domain Controller Information Checklist
 Information to Gather List the Information
 Active Directory server name
 Active Directory domain name
 Base DN
 For Active Directory over LDAP, the Bind DN usernameand password
 For Active Directory with Integrated WindowsAuthentication, the user name and password of the accountthat has privileges to join computers to the domain.
 Installing and Configuring VMware Identity Manager
 16 VMware, Inc.
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Table 1‑6. LDAP Directory Server Information Checklist
 Information to Gather List the Information
 LDAP directory server name or IP address
 LDAP directory server port number
 Base DN
 Bind DN username and password
 LDAP search filters for group objects, bind user objects,and user objects
 LDAP attribute names for membership, object UUID, anddistinguished name
 SSL CertificatesYou can add an SSL certificate after you deploy the VMware Identity Manager virtual appliance.
 Table 1‑7. SSL Certificate Information Checklist
 Information to Gather List the Information
 SSL certificate
 Private key
 License KeyTable 1‑8. VMware Identity Manager License Key Information Checklist
 Information to Gather List the Information
 License key
 Note The License key information is entered in the administration console in the Appliance Settings >License page after the installation is complete.
 External DatabaseTable 1‑9. External Database Information Checklist
 Information to Gather List the Information
 Database host name
 Port
 Username
 Password
 Customer Experience Improvement ProgramWhen you install the VMware Identity Manager virtual appliance, you can choose to participate inVMware's customer experience improvement program.
 If you participate in the program, VMware collects anonymous data about your deployment in order toimprove VMware's response to user requirements. No data that identifies your organization is collected.
 Chapter 1 Preparing to Install VMware Identity Manager
 VMware, Inc. 17
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Before collecting the data, VMware makes anonymous all fields that contain information that is specific toyour organization.
 Note If your network is configured to access the Internet through HTTP proxy, to send this information,you must adjust the proxy settings in the VMware Identity Manager virtual appliance. See “Setting ProxyServer Settings for VMware Identity Manager,” on page 29.
 Installing and Configuring VMware Identity Manager
 18 VMware, Inc.
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Deploying VMware Identity Manager 2To deploy VMware Identity Manager, you deploy the OVF template using the vSphere Client or the vSphereWeb Client, power on the VMware Identity Manager virtual appliance, and configure settings.
 After the VMware Identity Manager virtual appliance is deployed, you use the Setup wizard to set up theVMware Identity Manager environment.
 Use the information in the deployment checklist to complete the installation. See “Deployment Checklists,”on page 16.
 This chapter includes the following topics:
 n “Install the VMware Identity Manager OVA File,” on page 19
 n “(Optional) Add IP Pools,” on page 21
 n “Configure VMware Identity Manager Settings,” on page 21
 n “Setting Proxy Server Settings for VMware Identity Manager,” on page 29
 n “Enter the License Key,” on page 29
 Install the VMware Identity Manager OVA FileYou deploy the VMware Identity Manager OVA file using the vSphere Client or the vSphere Web Client.You can download and deploy the OVA file from a local location that is accessible to the vSphere Client, ordeploy it from a Web URL.
 Note If you are using the vSphere Web Client, use either Firefox or Chrome browsers to deploy the OVAfile. Do not use Internet Explorer.
 Prerequisites
 Review Chapter 1, “Preparing to Install VMware Identity Manager,” on page 9.
 Procedure
 1 Download the VMware Identity Manager OVA file from My VMware.
 2 Log in to the vSphere Client or the vSphere Web Client.
 3 Select File > Deploy OVF Template.
 VMware, Inc. 19
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4 In the Deploy OVF Template wizard, specify the following information.
 Page Description
 Source Browse to the OVA package location, or enter a specific URL.
 OVF Template Details Review the product details, including version and size requirements.
 End User License Agreement Read the End User License Agreement and click Accept.
 Name and Location Enter a name for the VMware Identity Manager virtual appliance. Thename must be unique within the inventory folder and can contain up to 80characters. Names are case sensitive.Select a location for the virtual appliance.
 Host / Cluster Select the host or cluster in which to run the virtual appliance.
 Resource Pool Select the resource pool.
 Storage Select the storage for the virtual appliance files. You can also select a VMStorage Profile.
 Disk Format Select the disk format for the files. For production environments, select oneof the Thick Provision formats. Use the Thin Provision format forevaluation and testing.In the Thick Provision format, all the space required for the virtual disk isallocated during deployment. In the Thin Provision format, the disk usesonly the amount of storage space that it needs for its initial operations.
 Network Mapping Map the networks used in VMware Identity Manager to networks in yourinventory.
 Properties a In the Timezone setting field, select the correct time zone.b The Customer Experience Improvement Program checkbox is selected
 by default. VMware collects anonymous data about your deploymentin order to improve VMware's response to user requirements. Deselectthe checkbox if you do not want the data collected.
 c In the Host Name (FQDN) text box, enter the host name to use. If thisis blank, reverse DNS is used to look up the host name.
 d Configure the networking properties.n To configure a static IP address for VMware Identity Manager,
 enter the address for the Default Gateway, DNS, IP Address, andNetmask fields.Note If you have a load balancer with a Virtual IP address (VIP)in front of the DNS servers, note that VMware Identity Managerdoes not support using a VIP. You can specify multiple DNSservers separated by a comma.Important If any of the four address fields, including HostName, are left blank, DHCP is used.
 n To configure DHCP, leave the address fields blank.Note The Domain Name and Domain Search Path fields are not used.You can leave these blank.(Optional) After VMware Identity Manager is installed, you can configureIP Pools. See “(Optional) Add IP Pools,” on page 21.
 Ready to Complete Review your selections and click Finish. Depending on your network speed, the deployment can take several minutes. You can view theprogress in the progress dialog box that appears.
 5 When the deployment is complete, click Close in the progress dialog box.
 6 Select the VMware Identity Manager virtual appliance you deployed, right-click, and select Power >Power on.
 The VMware Identity Manager virtual appliance is initialized. You can go to the Console tab to see thedetails. When the virtual appliance initialization is complete, the console screen displays theVMware Identity Manager version, IP address, and the URLs to log in to the VMware Identity ManagerWeb interface and to complete the set up.
 Installing and Configuring VMware Identity Manager
 20 VMware, Inc.

Page 21
                        
                        

What to do next
 n (Optional) Add IP Pools.
 n Configure VMware Identity Manager settings, including connecting to your Active Directory or LDAPdirectory and selecting users and groups to sync to VMware Identity Manager.
 (Optional) Add IP PoolsNetwork configuration with IP Pools is optional in VMware Identity Manager. You can manually add IPpools to the VMware Identity Manager virtual appliance after it is installed.
 IP Pools act like DHCP servers to assign IP addresses from the pool to the VMware Identity Manager virtualappliance. To use IP Pools, you edit the virtual appliance networking properties to change the properties todynamic properties and configure the netmask, gateway, and DNS settings.
 Prerequisites
 The virtual appliance must be powered off.
 Procedure
 1 In the vSphere Client or the vSphere Web Client, right-click the VMware Identity Manager virtualappliance and select Edit Settings.
 2 Select the Options tab.
 3 Under vApp Options, click Advanced.
 4 In the Properties section on the right, click the Properties button.
 5 In the Advanced Property Configuration dialog box, configure the following keys:
 n vami.DNS.WorkspacePortal
 n vami.netmask0.WorkspacePortal
 n vami.gateway.WorkspacePortal
 a Select one of the keys and click Edit.
 b In the Edit Property Settings dialog box, next to the Type field, click Edit.
 c In the Edit Property Type dialog box, select Dynamic Property and select the appropriate valuefrom the drop down menu for Netmask, Gateway Address, and DNS Servers respectively.
 d Click OK, and click OK again.
 e Repeat these steps to configure each key.
 6 Power on the virtual appliance.
 The properties are configured to use IP Pools.
 What to do next
 Configure VMware Identity Manager settings.
 Configure VMware Identity Manager SettingsAfter the VMware Identity Manager OVA is deployed, you use the Setup wizard to set passwords and selecta database. Then you set up the connection to your Active Directory or LDAP directory.
 Prerequisites
 n The VMware Identity Manager virtual appliance is powered on.
 Chapter 2 Deploying VMware Identity Manager
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n If you are using an external database, the external database is configured and the external databaseconnection information is available. See “Connecting to the Database,” on page 32 for information.
 n Review Chapter 4, “Integrating with Your Enterprise Directory,” on page 43, “Integrating with ActiveDirectory,” on page 44, and “Integrate an LDAP Directory with the Service,” on page 58 forrequirements and limitations.
 n You have your Active Directory or LDAP directory information.
 n When multi-forest Active Directory is configured and the Domain Local group contains members fromdomains in different forests, the Bind DN user used on the VMware Identity Manager Directory pagemust be added to the Administrators group of the domain in which Domain Local group resides. If thisis not done, these members will be missing from the Domain Local group.
 n You have a list of the user attributes you want to use as filters, and a list of the groups you want to addto VMware Identity Manager.
 Procedure
 1 Go to the VMware Identity Manager URL that is shown on the blue screen in the Console tab. Forexample, https://hostname.example.com.
 2 Accept the certificate, if prompted.
 3 In the Get Started page, click Continue.
 4 In the Set Passwords page, set passwords for the following administrator accounts, which are used tomanage the appliance, then click Continue.
 Account
 Appliance Administrator Set the password for the admin user. This user name cannot bechanged. The admin user account is used to manage the appliancesettings.Important The admin user password must be at least 6 charactersin length.
 Appliance Root Set the root user password. The root user has full rights to theappliance.
 Remote User Set the sshuser password, which is used to log in remotely to theappliance with an SSH connection.
 5 In the Select Database page, select the database to use.
 See “Connecting to the Database,” on page 32 for more information.
 n If you are using an external database, select External Database and enter the external databaseconnection information, user name, and password. To verify that VMware Identity Manager canconnect to the database, click Test Connection.
 After you verify the connection, click Continue.
 n If you are using the internal database, click Continue.
 Note The internal database is not recommended for use with production deployments.
 The connection to the database is configured and the database is initialized. When the process iscomplete, the Setup is complete page appears.
 6 Click the Log in to the administration console link on the Setup is complete page to log in to theadministration console to set up the Active Directory or LDAP directory connection.
 Installing and Configuring VMware Identity Manager
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7 Log in to the administration console as the admin user, using the password you set.
 You are logged in as a Local Admin. The Directories page appears. Before you add a directory, ensurethat you review Chapter 4, “Integrating with Your Enterprise Directory,” on page 43, “Integrating withActive Directory,” on page 44, and “Integrate an LDAP Directory with the Service,” on page 58 forrequirements and limitations.
 8 Click the Identity & Access Management tab.
 9 Click Setup > User Attributes to select the user attributes to sync to the directory.
 Default attributes are listed and you can select the ones that are required. If an attribute is markedrequired, only users with that attribute are synced to the service. You can also add other attributes.
 Important After a directory is created, you cannot change an attribute to be a required attribute. Youmust make that selection now.
 Also, be aware that the settings in the User Attributes page apply to all directories in the service. Whenyou mark an attribute required, consider the effect on other directories. If an attribute is markedrequired, users without that attribute are not synced to the service.
 Important If you plan to sync XenApp resources to VMware Identity Manager, you must makedistinguishedName a required attribute.
 10 Click Save.
 11 Click the Identity & Access Management tab.
 12 In the Directories page, click Add Directory and select Add Active Directory over LDAP/IWA or AddLDAP Directory, based on the type of directory you are integrating.
 You can also create a local directory in the service. For more information about using local directories,see Chapter 5, “Using Local Directories,” on page 63.
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13 For Active Directory, follow these steps.
 a Enter a name for the directory you are creating in VMware Identity Manager and select the type ofdirectory, either Active Directory over LDAP or Active Directory (Integrated WindowsAuthentication).
 b Provide the connection information.
 Option Description
 Active Directory over LDAP 1 In the Sync Connector field, select the connector you want to use tosync users and groups from Active Directory to theVMware Identity Manager directory.
 A connector component is always available with theVMware Identity Manager service by default. This connectorappears in the drop-down list. If you install multipleVMware Identity Manager appliances for high availability, theconnector component of each appears in the list.
 2 In the Authentication field, select Yes if you want to use this ActiveDirectory to authenticate users.
 If you want to use a third-party identity provider to authenticateusers, click No. After you configure the Active Directoryconnection to sync users and groups, go to the Identity & AccessManagement > Manage > Identity Providers page to add the third-party identity provider for authentication.
 3 In the Directory Search Attribute field, select the account attributethat contains username.
 4 If the Active Directory uses DNS Service Location lookup, make thefollowing selections.n In the Server Location section, select the This Directory
 supports DNS Service Location checkbox.
 A domain_krb.properties file, auto-populated with a list ofdomain controllers, will be created when the directory iscreated. See “About Domain Controller Selection(domain_krb.properties file),” on page 47 .
 n If the Active Directory requires STARTTLS encryption, selectthe This Directory requires all connections to use SSL checkbox in the Certificates section and copy and paste the ActiveDirectory Root CA certificate into the SSL Certificate field.
 Ensure the certificate is in PEM format and include the "BEGINCERTIFICATE" and "END CERTIFICATE" lines.Note If the Active Directory requires STARTTLS and you donot provide the certificate, you cannot create the directory.
 5 If the Active Directory does not use DNS Service Location lookup,make the following selections.n In the Server Location section, verify that the This Directory
 supports DNS Service Location checkbox is not selected andenter the Active Directory server host name and port number.
 To configure the directory as a global catalog, see the Multi-Domain, Single Forest Active Directory Environment section in “Active Directory Environments,” on page 45.
 n If the Active Directory requires access over SSL, select the ThisDirectory requires all connections to use SSL check box in theCertificates section and copy and paste the Active DirectoryRoot CA certificate into the SSL Certificate field.
 Ensure the certificate is in PEM format and include the "BEGINCERTIFICATE" and "END CERTIFICATE" lines.Note If the Active Directory requires SSL and you do notprovide the certificate, you cannot create the directory.
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Option Description6 In the Allow Change Password section, select Enable Change
 Password if you want to allow users to reset their passwords fromthe VMware Identity Manager login page if the password expiresor if the Active Directory administrator resets the user's password.
 7 In the Base DN field, enter the DN from which to start accountsearches. For example, OU=myUnit,DC=myCorp,DC=com.
 8 In the Bind DN field, enter the account that can search for users.For example, CN=binduser,OU=myUnit,DC=myCorp,DC=com.Note Using a Bind DN user account with a non-expiringpassword is recommended.
 9 After you enter the Bind password, click Test Connection to verifythat the directory can connect to your Active Directory.
 Active Directory (IntegratedWindows Authentication)
 1 In the Sync Connector field, select the connector you want to use tosync users and groups from Active Directory to theVMware Identity Manager directory.
 A connector component is always available with theVMware Identity Manager service by default. This connectorappears in the drop-down list. If you install multipleVMware Identity Manager appliances for high availability, theconnector component of each appears in the list.
 2 In the Authentication field, if you want to use this Active Directoryto authenticate users, click Yes.
 If you want to use a third-party identity provider to authenticateusers, click No. After you configure the Active Directoryconnection to sync users and groups, go to the Identity & AccessManagement > Manage > Identity Providers page to add the third-party identity provider for authentication.
 3 In the Directory Search Attribute field, select the account attributethat contains username.
 4 If the Active Directory requires STARTTLS encryption, select theThis Directory requires all connections to use STARTTLScheckbox in the Certificates section and copy and paste the ActiveDirectory Root CA certificate into the SSL Certificate field.
 Ensure the certificate is in PEM format and include the "BEGINCERTIFICATE" and "END CERTIFICATE" lines.
 If the directory has multiple domains, add the Root CA certificatesfor all domains, one at a time.Note If the Active Directory requires STARTTLS and you do notprovide the certificate, you cannot create the directory.
 5 Enter the name of the Active Directory domain to join. Enter a username and password that has the rights to join the domain. See “Permissions Required for Joining a Domain,” on page 52 formore information.
 6 In the Allow Change Password section, select Enable ChangePassword if you want to allow users to reset their passwords fromthe VMware Identity Manager login page if the password expiresor if the Active Directory administrator resets the user's password.
 7 In the Bind User UPN field, enter the User Principal Name of theuser who can authenticate with the domain. For example,[email protected] Using a Bind DN user account with a non-expiringpassword is recommended.
 8 Enter the Bind DN User password.
 c Click Save & Next.
 The page with the list of domains appears.
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14 For LDAP directories, follow these steps.
 a Provide the connection information.
 Option Description
 Directory Name A name for the directory you are creating in VMware Identity Manager.
 Directory Sync and Authentication 1 In the Sync Connector field, select the connector you want to use tosync users and groups from your LDAP directory to theVMware Identity Manager directory.
 A connector component is always available with theVMware Identity Manager service by default. This connectorappears in the drop-down list. If you install multipleVMware Identity Manager appliances for high availability, theconnector component of each appears in the list.
 You do not need a separate connector for an LDAP directory. Aconnector can support multiple directories, regardless of whetherthey are Active Directory or LDAP directories.
 2 In the Authentication field, select Yes if you want to use this LDAPdirectory to authenticate users.
 If you want to use a third-party identity provider to authenticateusers, select No. After you add the directory connection to syncusers and groups, go to the Identity & Access Management >Manage > Identity Providers page to add the third-party identityprovider for authentication.
 3 In the Directory Search Attribute field, specify the LDAP directoryattribute to be used for user name. If the attribute is not listed,select Custom and type the attribute name. For example, cn.
 Server Location Enter the LDAP Directory server host and port number. For the serverhost, you can specify either the fully-qualified domain name or the IPaddress. For example, myLDAPserver.example.com or 100.00.00.0.If you have a cluster of servers behind a load balancer, enter the loadbalancer information instead.
 LDAP Configuration Specify the LDAP search filters and attributes thatVMware Identity Manager can use to query your LDAP directory.Default values are provided based on the core LDAP schema.LDAP Queriesn Get groups: The search filter for obtaining group objects.
 For example: (objectClass=group)n Get bind user: The search filter for obtaining the bind user object,
 that is, the user that can bind to the directory.
 For example: (objectClass=person)n Get user: The search filter for obtaining users to sync.
 For example:(&(objectClass=user)(objectCategory=person))
 Attributesn Membership: The attribute that is used in your LDAP directory to
 define the members of a group.
 For example: membern Object UUID: The attribute that is used in your LDAP directory to
 define the UUID of a user or group.
 For example: entryUUIDn Distinguished Name: The attribute that is used in your LDAP
 directory for the distinguished name of a user or group.
 For example: entryDN
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Option Description
 Certificates If your LDAP directory requires access over SSL, select the ThisDirectory requires all connections to use SSL and copy and paste theLDAP directory server's root CA SSL certificate. Ensure the certificate isin PEM format and include the "BEGIN CERTIFICATE" and "ENDCERTIFICATE" lines.
 Bind User Details Base DN: Enter the DN from which to start searches. For example,cn=users,dc=example,dc=comBind DN: Enter the user name to use to bind to the LDAP directory.Note Using a Bind DN user account with a non-expiring password isrecommended.Bind DN Password: Enter the password for the Bind DN user.
 b To test the connection to the LDAP directory server, click Test Connection.
 If the connection is not successful, check the information you entered and make the appropriatechanges.
 c Click Save & Next.
 The page listing the domain appears.
 15 For an LDAP directory, the domain is listed and cannot be modified.
 For Active Directory over LDAP, the domains are listed and cannot be modified.
 For Active Directory (Integrated Windows Authentication), select the domains that should beassociated with this Active Directory connection.
 Note If you add a trusting domain after the directory is created, the service does not automaticallydetect the newly trusting domain. To enable the service to detect the domain, the connector must leaveand then rejoin the domain. When the connector rejoins the domain, the trusting domain appears in thelist.
 Click Next.
 16 Verify that the VMware Identity Manager attribute names are mapped to the correct Active Directory orLDAP attributes and make changes, if necessary.
 Important If you are integrating an LDAP directory, you must specify a mapping for the domainattribute.
 17 Click Next.
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18 Select the groups you want to sync from your Active Directory or LDAP directory to theVMware Identity Manager directory.
 Option Description
 Specify the group DNs To select groups, you specify one or more group DNs and select the groupsunder them.a Click + and specify the group DN. For example,
 CN=users,DC=example,DC=company,DC=com.Important Specify group DNs that are under the Base DN that youentered. If a group DN is outside the Base DN, users from that DN willbe synced but will not be able to log in.
 b Click Find Groups.
 The Groups to Sync column lists the number of groups found in theDN.
 c To select all the groups in the DN, click Select All, otherwise clickSelect and select the specific groups to sync.Note If you have multiple groups with the same name in your LDAPdirectory, you must specify unique names for them inVMware Identity Manager. You can change the name while selectingthe group.
 Note When you sync a group, any users that do not have Domain Usersas their primary group in Active Directory are not synced.
 Sync nested group members The Sync nested group members option is enabled by default. When thisoption is enabled, all the users that belong directly to the group you selectas well as all the users that belong to nested groups under it are synced.Note that the nested groups are not synced; only the users that belong tothe nested groups are synced. In the VMware Identity Manager directory,these users will be members of the parent group that you selected for sync.If the Sync nested group members option is disabled, when you specify agroup to sync, all the users that belong directly to that group are synced.Users that belong to nested groups under it are not synced. Disabling thisoption is useful for large Active Directory configurations where traversinga group tree is resource and time intensive. If you disable this option,ensure that you select all the groups whose users you want to sync.
 19 Click Next.
 20 Specify additional users to sync, if required.
 a Click + and enter the user DNs. For example,CN=username,CN=Users,OU=myUnit,DC=myCorp,DC=com.
 Important Specify user DNs that are under the Base DN that you entered. If a user DN is outsidethe Base DN, users from that DN will be synced but will not be able to log in.
 b (Optional) To exclude users, create a filter to exclude some types of users.
 You select the user attribute to filter by, the query rule, and the value.
 21 Click Next.
 22 Review the page to see how many users and groups will sync to the directory and to view the syncschedule.
 To make changes to users and groups, or to the sync frequency, click the Edit links.
 23 Click Sync Directory to start the directory sync.
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Note If a networking error occurs and the host name cannot be uniquely resolved using reverse DNS, theconfiguration process stops. You must fix the networking problems and restart the virtual appliance. Then,you can continue the deployment process. The new network settings are not available until after you restartthe virtual appliance.
 What to do next
 For information about setting up a load balancer or a high-availability configuration, see Chapter 6,“Advanced Configuration for the VMware Identity Manager Appliance,” on page 71.
 You can customize the catalog of resources for your organization's applications and enable user access tothese resources. You can also set up other resources, including View, ThinApp, and Citrix-basedapplications. See Setting up Resources in VMware Identity Manager.
 Setting Proxy Server Settings for VMware Identity ManagerThe VMware Identity Manager virtual appliance accesses the cloud application catalog and other Webservices on the Internet. If your network configuration provides Internet access through an HTTP proxy, youmust adjust your proxy settings on the VMware Identity Manager appliance.
 Enable your proxy to handle only Internet traffic. To ensure that the proxy is set up correctly, set theparameter for internal traffic to no-proxy within the domain.
 Note Proxy servers that require authentication are not supported.
 Procedure
 1 From the vSphere Client, log in as the root user to the VMware Identity Manager virtual appliance.
 2 Enter YaST on the command line to run the YaST utility.
 3 Select Network Services in the left pane, then select Proxy.
 4 Enter the proxy server URLs in the HTTP Proxy URL and HTTPS Proxy URL fields.
 5 Select Finish and exit the YaST utility.
 6 Restart the Tomcat server on the VMware Identity Manager virtual appliance to use the new proxysettings.
 service horizon-workspace restart
 The cloud application catalog and other Web services are now available in VMware Identity Manager.
 Enter the License KeyAfter you deploy the VMware Identity Manager appliance, enter your license key.
 Procedure
 1 Log in to the VMware Identity Manager administration console.
 2 Select the Appliance Settings tab, then click License.
 3 In the License Settings page, enter the license key and click Save.
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Managing Appliance SystemConfiguration Settings 3
 After the initial appliance configuration is complete, you can go to the appliance admin pages to installcertificates, manage passwords, and monitor system information for the virtual appliance.
 You can also update the database, FQDN, and syslog, and download log files.
 Page Name Setting Description
 Database Connection The database connection setting, either Internal or External,is enabled. You can change the database type. When youselect External Database, you enter the external databaseURL, user name, and password. To set up an externaldatabase, see “Connecting to the Database,” on page 32.
 Install Certificate On this page, you install a custom or self-signed certificatefor VMware Identity Manager and, ifVMware Identity Manager is configured with a loadbalancer, you can install the load balancer's root certificate.The location of the VMware Identity Manager root CAcertificate is displayed on this page as well, on theTerminate SSL on a Load Balancer tab. See “Using SSLCertificates,” on page 35.
 Identity Manager FQDN The VMware Identity Manager FQDN is displayed on thispage. You can change it. VMware Identity Manager FQDNis the URL that users use to access the service.
 Configure Syslog On this page, you can enable an external syslog server.VMware Identity Manager logs are sent to this externalserver. See “Enable the Syslog Server,” on page 39.
 Change Password On this page, you can change theVMware Identity Manager admin user password.
 System Security On this page, you can change the root password for theVMware Identity Manager appliance and the ssh userpassword used to log in remotely.
 Log File Locations A list of log files and their directory locations is displayedon this page. You can bundle the log files into a zip file todownload. See “Log File Information,” on page 39.
 You can also modify the connector URL. See “Modifying the Connector URL,” on page 38.
 This chapter includes the following topics:
 n “Change Appliance Configuration Settings,” on page 32
 n “Connecting to the Database,” on page 32
 n “Using SSL Certificates,” on page 35
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n “Modifying the VMware Identity Manager Service URL,” on page 38
 n “Modifying the Connector URL,” on page 38
 n “Enable the Syslog Server,” on page 39
 n “Log File Information,” on page 39
 n “Manage Your Appliance Passwords,” on page 40
 n “Configure SMTP Settings,” on page 41
 Change Appliance Configuration SettingsAfter you configure VMware Identity Manager, you can go to the Appliance Settings pages to update thecurrent configuration and monitor system information for the virtual appliance.
 Procedure
 1 Log in to the administration console.
 2 Select the Appliance Settings tab and click Manage Configuration.
 3 Log in with the service administrator password.
 4 In the left pane, select the page to view or edit.
 What to do next
 Verify that the settings or updates you make are in effect.
 Connecting to the DatabaseAn internal PostgreSQL database is embedded in the VMware Identity Manager appliance but it is notrecommended for use with production deployments. To use an external database withVMware Identity Manager, your database administrator must prepare an empty database and schemabefore connecting to the database in VMware Identity Manager.
 You can connect to the external database connection when you run the VMware Identity Manager Setupwizard. You can also go to the Appliance Settings > VA Configuration > Database Connection Setup page toconfigure the connection to the external database.
 Licensed users can use an external Oracle database or Microsoft SQL Server to set up a high availabilitydatabase environment.
 Configure a Microsoft SQL DatabaseTo use a Microsoft SQL database for the VMware Identity Manager, you must create a new database in theMicrosoft SQL server.
 You create for a database named saas on the Microsoft SQL server and create a login user named horizon.
 Note The default collation is case-sensitve.
 Prerequisites
 n Supported version of the Microsoft SQL server installed as an external database server.
 n Load balancing implementation configured.
 n Administrator rights to access and create the database components using Microsoft SQL ServerManagement Studio or from another Microsoft SQL Server CLI client.
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Procedure
 1 Log in to the Microsoft SQL Server Management Studio session as the sysadmin or a user account withsysadmin privileges.
 The editor window appears.
 2 In the toolbar, click New Query.
 3 Cut and paste the following commands into the editor window.
 Microsoft SQL Commands
 CREATE DATABASE saas
 COLLATE Latin1_General_CS_AS;
 ALTER DATABASE saas SET READ_COMMITTED_SNAPSHOT ON;
 GO
 BEGIN
 CREATE LOGIN horizon WITH PASSWORD = N'H0rizon!';
 END
 GO
 USE saas;
 IF EXISTS (SELECT * FROM sys.database_principals WHERE name = N'horizon')
 DROP USER [horizon]
 GO
 CREATE USER horizon FOR LOGIN horizon
 WITH DEFAULT_SCHEMA = saas;
 GO
 CREATE SCHEMA saas AUTHORIZATION horizon
 GRANT ALL ON DATABASE::saas TO horizon;
 GO
 4 On the toolbar, click !Execute.
 The Microsoft SQL database server is now ready to be connected to the VMware Identity Managerdatabase
 What to do next
 Configure the external database on the VMware Identity Manager server. Go to the VMware IdentityManager administration console Appliance Settings > VA Configuration > Database Connection Setup page.Enter the JDBC URL as jdbc:sqlserver://<hostname-or-DB_VM_IP_ADDR>;DatabaseName=saas. Enter the username and password created for the database. See “Configure VMware Identity Manager to Use an ExternalDatabase,” on page 35
 Configure an Oracle DatabaseDuring the Oracle database installation, you must specify certain Oracle configurations for optimumperformance with VMware Identity Manager.
 Prerequisites
 The Oracle database you create is going to be called saas. VMware Identity Manager requires Oracle quotedidentifiers for the username and schema. Therefore, you must use double quotes when you create the Oraclesaas username and schema.
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Procedure
 1 Specify the following settings when creating an Oracle database.
 a Select the General Purpose/Transaction Processing Database configuration option.
 b Click Use Unicode > UTF8.
 c Use National Character Set.
 2 Connect to the Oracle database after the installation is finished.
 3 Log in to the Oracle database as the sys user.
 4 Increase the process connections. Each additional service virtual machine requires a minimum of 300process connections to function with VMware Identity Manager. For example, if your environment hastwo service virtual machines, run the alter command as sys or system user.
 a Increase the process connections using the alter command.
 alter system set processes=600 scope=spfile
 b Restart the database.
 5 Create a database trigger that all users can use.
 Sample SQL to Create a Database Trigger
 CREATE OR REPLACETRIGGER CASE_INSENSITIVE_ONLOGONAFTER LOGON ON DATABASEDECLAREusername VARCHAR2(30);BEGINusername:=SYS_CONTEXT('USERENV','SESSION_USER');IF username = 'saas' THENexecute immediate 'alter session set NLS_SORT=BINARY_CI';execute immediate 'alter session set NLS_COMP=LINGUISTIC';END IF;EXCEPTIONWHEN OTHERS THENNULL;END;
 6 Run the Oracle commands to create a new user schema.
 Sample SQL to Create a New User
 CREATE USER "saas"IDENTIFIED BY <password>DEFAULT TABLESPACE USERSTEMPORARY TABLESPACE TEMPPROFILE DEFAULTACCOUNT UNLOCK;GRANT RESOURCE TO "saas" ;GRANT CONNECT TO "saas" ;ALTER USER "saas" DEFAULT ROLE ALL;GRANT UNLIMITED TABLESPACE TO "saas";
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Administering the Internal DatabaseThe internal PostgreSQL database is configured and ready to use by default. Note that the internal databaseis not recommended for use with production deployments.
 When the VMware Identity Manager is installed and powered on, during the initialization process, arandom password for the internal database user is generated. This password is unique to each deploymentand can be found in the file /usr/local/horizon/conf/db.pwd.
 To configure your internal database for high availability, see KB 2094258.
 Configure VMware Identity Manager to Use an External DatabaseAfter you set up the database in the VMware Identity Manager Setup wizard, you can configureVMware Identity Manager to use a different database.
 You must point VMware Identity Manager to an initialized, populated database. For example, you can use adatabase configured as the result of a successful run of the VMware Identity Manager Setup wizard, adatabase from a backup, or an existing database from a recovered snapshot.
 Prerequisites
 n Install and configure the supported Microsoft SQL or Oracle edition as the external database server. Forinformation about specific versions that are supported by VMware Identity Manager, see the VMwareProduct Interoperability Matrixes athttp://www.vmware.com/resources/compatibility/sim/interop_matrix.php.
 Procedure
 1 In the administration console click Appliance Settings and select VA Configuration.
 2 Click Manage Configuration.
 3 Log in with the VMware Identity Manager administrator password.
 4 On the Database Connection Setup page, select External Database as the database type.
 5 Enter information about the database connection.
 a Type the JDBC URL of the database server.
 Microsoft SQL jdbc:sqlserver://hostname_or_IP_address;DatabaseName=horizon
 Oracle jdbc:oracle:thin:@//hostname_or_IP_address:port/sid
 b Type the name of the user with read and write privileges to the database.
 Microsoft SQL horizon
 Oracle “saas”
 c Type the password for the user you created when you configured the database.
 6 Click Test Connection to verify and save the information.
 Using SSL CertificatesWhen the VMware Identity Manager appliance is installed, a default SSL server certificate is automaticallygenerated. You can use this self-signed certificate for general testing of your implementation. VMwarestrongly recommends that you generate and install commercial SSL certificates in your productionenvironment.
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A certificate of authority (CA) is a trusted entity that guarantees the identity of the certificate and its creator.When a certificate is signed by a trusted CA, users no longer receive messages asking them to verify thecertificate.
 If you deploy VMware Identity Manager with the self-signed SSL certificate, the root CA certificate must beavailable as a trusted CA for any client who accesses the VMware Identity Manager. The clients can includeend user machines, load balancers, proxies, and so on. You can download the root CA fromhttps://myconnector.domain.com/horizon_workspace_rootca.pem.
 You can install a signed CA certificate from the Appliance Settings > Manage Configuration > InstallCertificate page. You can also add the load balancer's root CA certificate on this page as well.
 Apply Public Certificate AuthorityWhen the VMware Identity Manager service is installed, a default SSL server certificate is generated. Youcan use the default certificate for testing purposes. You should generate and install commercial SSLcertificates for your environment.
 Note If the VMware Identity Manager points to a load balancer, the SSL certificate is applied to the loadbalancer.
 Prerequisites
 Generate a Certificate Signing Request (CSR) and obtain a valid, signed certificate from a CA. If yourorganization provides SSL certificates that are signed by a CA, you can use these certificates. The certificatemust be in the PEM format.
 Procedure
 1 In the administration console, click Appliance Settings.
 VA configuration is selected by default.
 2 Click Manage Configuration.
 3 In the dialog box that appears, enter the VMware Identity Manager server admin user password.
 4 Select Install Certificate.
 5 In the Terminate SSL on Identity Manager Appliance tab, select Custom Certificate.
 6 In the SSL Certificate Chain text box, paste the host, intermediate, and root certificates, in that order.
 The SSL certificate works only if you include the entire certificate chain in the correct order. For eachcertificate, copy everything between and including the lines -----BEGIN CERTIFICATE----- and -----ENDCERTIFICATE----
 Ensure that the certificate includes the FQDN hostname.
 7 Paste the private key in the Private Key text box. Copy everything between ----BEGIN RSA PRIVATEKEY and ---END RSA PRIVATE KEY.
 8 Click Save.
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Example: Certificate Examples
 Certificate Chain Example
 -----BEGIN CERTIFICATE-----
 jlQvt9WdR9Vpg3WQT5+C3HU17bUOwvhp/r0+.........W53+O05j5xsxzDJfWr1lqBlFF/OkIYCPcyK1
 -----END CERTIFICATE-----
 -----BEGIN CERTIFICATE-----
 WdR9Vpg3WQT5+C3HU17bUOwvhp/rjlQvt90+.........O05j5xsxzDJfWr1lqBlFF/OkIYCPW53+cyK1
 -----END CERTIFICATE-----
 -----BEGIN CERTIFICATE-----
 dR9Vpg3WQTjlQvt9W5+C3HU17bUOwvhp/r0+.........5j5xsxzDJfWr1lqW53+O0BlFF/OkIYCPcyK1
 -----END CERTIFICATE-----
 Private Key Example
 -----BEGIN RSA PRIVATE KEY-----
 jlQvtg3WQT5+C3HU17bU9WdR9VpOwvhp/r0+.........1lqBlFFW53+O05j5xsxzDJfWr/OkIYCPcyK1
 -----END RSA PRIVATE KEY-----
 Adding SSL CertificatesWhen you apply the certificate make sure that you include the entire certificate chain. The certificate to beinstalled must be in the PEM format.
 The SSL certificate works only if you include the entire certificate chain. For each certificate, copy everythingbetween and including the lines that include -----BEGIN CERTIFICATE----- and -----END CERTIFICATE----.
 Important You must add the certificate chain in the order of SSL Certificate, Intermediate CA Certificates,Root CA Certificate.
 Certificate Chain Example
 -----BEGIN CERTIFICATE-----
 SSL Cert - Appliance SSL Cert
 -----END CERTIFICATE-----
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Certificate Chain Example
 -----BEGIN CERTIFICATE-----
 Intermediate/Issuing CA Cert
 -----END CERTIFICATE-----
 -----BEGIN CERTIFICATE-----
 Root CA Cert
 -----END CERTIFICATE-----
 Modifying the VMware Identity Manager Service URLYou can change the VMware Identity Manager service URL, which is the URL that users use to access theservice. For example, you might change the URL to a load balancer URL.
 Procedure
 1 Log into the VMware Identity Manager administration console.
 2 Click the Appliance Settings tab, then select VA Configuration.
 3 Click Manage Configuration and log in with the admin user password.
 4 Click Identity Manager FQDN and enter the new URL in the Identity Manager FQDN field.
 Use the format https://FQDN:port. Specifying a port is optional. The default port is 443.
 For example, https://myservice.example.com.
 5 Click Save.
 What to do next
 Enable the new portal user interface.
 1 Go to https://VMwareIdentityManagerURL/admin to access the administration console.
 2 In the administration console, click the arrow on the Catalog tab and select Settings.
 3 Select New End User Portal UI in the left pane and click Enable New Portal UI.
 Modifying the Connector URLYou can change the connector URL by updating the identity provider hostname in the administrationconsole. If you are using the connector as the identity provider, the connector URL is the URL of the loginpage and is visible to end users.
 Procedure
 1 Log in to the VMware Identity Manager administration console.
 2 Click the Identity & Access Management tab, then click the Identity Providers tab.
 3 In the Identity Providers page, select the identity provider to update.
 4 In the IdP Hostname field, enter the new hostname.
 Use the format hostname:port. Specifying a port is optional. The default port is 443.
 For example, vidm.example.com.
 5 Click Save.
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Enable the Syslog ServerApplication-level events from the service can be exported to an external syslog server. Operating systemevents are not exported.
 Since most companies do not have unlimited disk space, the virtual appliance does not save the completelogging history. If you want to save more history or create a centralized location for your logging history,you can set up an external syslog server.
 If you do not specify a syslog server during the initial configuration, you can configure it later from theAppliance Settings > VA Configuration > Manage Configuration > Syslog Configuration page.
 Prerequisites
 Set up an external syslog server. You can use any of the standard syslog servers available. Several syslogservers include advanced search capabilities.
 Procedure
 1 Log in to the administration console.
 2 Click the Appliance Settings tab, select VA Configuration in the left pane, and click ManageConfiguration.
 3 Select Configure Syslog in the left pane.
 4 Click Enable.
 5 Enter the IP address or the FQDN of the syslog server where you want to store the logs.
 6 Click Save.
 A copy of your logs is sent to the syslog server.
 Log File InformationThe VMware Identity Manager log files can help you debug and troubleshoot. The log files listed below area common starting point. Additional logs can be found in the /opt/vmware/horizon/workspace/logsdirectory.
 Table 3‑1. Log Files
 Component Location of Log File Description
 Identity ManagerService Logs
 /opt/vmware/horizon/workspace/logs/horizon.log
 Information about activity on theVMware Identity Manager application, such asentitlements, users, and groups.
 Configurator Logs /opt/vmware/horizon/workspace/logs/configurator.log
 Requests that the Configurator receives from the RESTclient and the Web interface.
 Connector Logs /opt/vmware/horizon/workspace/logs/connector.log
 A record of each request received from the Webinterface. Each log entry also includes the requestURL, timestamp, and exceptions. No sync actions arerecorded.
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Table 3‑1. Log Files (Continued)
 Component Location of Log File Description
 Update Logs /opt/vmware/var/log/update.log
 /opt/vmware/var/log/vami
 A record of output messages related to updaterequests during an upgrade ofVMware Identity Manager.The files in the /opt/vmware/var/log/vamidirectory are useful for troubleshooting. You can findthese files on all virtual machines after an upgrade.
 Apache TomcatLogs
 /opt/vmware/horizon/workspace/logs/catalina.log
 Apache Tomcat records of messages that are notrecorded in other log files.
 Collect Log InformationDuring testing or troubleshooting, the logs can give feedback about the activity and performance of thevirtual appliance, as well as information about any problems that occur.
 You collect the logs from each appliance that is in your environment.
 Procedure
 1 Log in to the administration console.
 2 Select the Appliance Settings tab and click Manage Configuration.
 3 Click Log File Locations and click Prepare log bundle.
 The information is collected into a tar.gz file that can be downloaded.
 4 Download the prepared bundle.
 What to do next
 To collect all logs, do this on each appliance.
 Manage Your Appliance PasswordsWhen you configured the virtual appliance, you created passwords for the admin user, root user, andsshuser. You can change these passwords from the Appliance Settings pages.
 Make sure that you create strong passwords. Strong passwords should be at least eight characters long andinclude uppercase and lowercase characters and at least one digit or special character.
 Procedure
 1 In the administration console, click the Appliance Settings tab.
 2 Click VA Configuration > Manage Configuration.
 3 To change the admin password, select Change Password. To change the root or sshuser passwords,select System Security.
 Important The admin user password must be at least 6 characters in length.
 4 Enter the new password.
 5 Click Save.
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Configure SMTP SettingsConfigure SMTP server settings to receive email notifications from the VMware Identity Manager service.
 Notification emails are sent to new users that are created as local users and when a password is reset in theVMware Identity Manager service.
 Procedure
 1 Log in to the administration console.
 2 Select the Appliance Settings tab and click SMTP.
 3 Enter the SMTP server host name.
 For example: smtp.example.com
 4 Enter the SMTP server port number.
 For example: 25
 5 (Optional) Enter a user name and password, if the SMTP server requires authentication.
 6 Click Save.
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Integrating with Your EnterpriseDirectory 4
 You integrate VMware Identity Manager with your enterprise directory to sync users and groups from yourenterprise directory to the VMware Identity Manager service.
 The following types of directories are supported.
 n Active Directory over LDAP
 n Active Directory, Integrated Windows Authentication
 n LDAP directory
 To integrate with your enterprise directory, you perform the following tasks.
 n Specify the attributes that you want users to have in the VMware Identity Manager service.
 n Create a directory in the VMware Identity Manager service of the same type as your enterprisedirectory and specify the connection details.
 n Map the VMware Identity Manager attributes to attributes used in your Active Directory or LDAPdirectory.
 n Specify the users and groups to sync.
 n Sync users and groups.
 After you integrate your enterprise directory and perform the initial sync, you can update the configuration,set up a sync schedule to sync regularly, or start a sync at any time.
 This chapter includes the following topics:
 n “Important Concepts Related to Directory Integration,” on page 43
 n “Integrating with Active Directory,” on page 44
 n “Integrating with LDAP Directories,” on page 58
 n “Adding a Directory After Configuring Failover and Redundancy,” on page 62
 Important Concepts Related to Directory IntegrationSeveral concepts are integral to understanding how the VMware Identity Manager service integrates withyour Active Directory or LDAP directory environment.
 ConnectorThe connector, a component of the service, performs the following functions.
 n Syncs user and group data from your Active Directory or LDAP directory to the service.
 n When being used as an identity provider, authenticates users to the service.
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The connector is the default identity provider. You can also use third-party identity providers thatsupport the SAML 2.0 protocol. Use a third-party identity provider for an authentication type theconnector does not support, or if the third-party identity provider is preferable based on yourenterprise security policy.
 Note If you use third-party identity providers, you can either configure the connector to sync user andgroup data or configure Just-in-Time user provisioning. See the Just-in-Time User Provisioning sectionin VMware Identity Manager Administration for more information.
 DirectoryThe VMware Identity Manager service has its own concept of a directory, corresponding to the ActiveDirectory or LDAP directory in your environment. This directory uses attributes to define users and groups.You create one or more directories in the service and then sync those directories with your Active Directoryor LDAP directory. You can create the following directory types in the service.
 n Active Directory
 n Active Directory over LDAP. Create this directory type if you plan to connect to a single ActiveDirectory domain environment. For the Active Directory over LDAP directory type, the connectorbinds to Active Directory using simple bind authentication.
 n Active Directory, Integrated Windows Authentication. Create this directory type if you plan toconnect to a multi-domain or multi-forest Active Directory environment. The connector binds toActive Directory using Integrated Windows Authentication.
 The type and number of directories that you create varies depending on your Active Directoryenvironment, such as single domain or multi-domain, and on the type of trust used between domains.In most environments, you create one directory.
 n LDAP Directory
 The service does not have direct access to your Active Directory or LDAP directory. Only the connector hasdirect access. Therefore, you associate each directory created in the service with a connector instance.
 WorkerWhen you associate a directory with a connector instance, the connector creates a partition for the associateddirectory called a worker. A connector instance can have multiple workers associated with it. Each workeracts as an identity provider. You define and configure authentication methods per worker.
 The connector syncs user and group data between your Active Directory or LDAP directory and the servicethrough one or more workers.
 Important You cannot have two workers of the Active Directory, Integrated Windows Authentication typeon the same connector instance.
 Security ConsiderationsFor enterprise directories integrated with the VMware Identity Manager service, security settings such asuser password complexity rules and account lockout policies must be set in the enterprise directory directly.VMware Identity Manager does not override these settings.
 Integrating with Active DirectoryYou can integrate VMware Identity Manager with your Active Directory deployment to sync users andgroups from Active Directory to VMware Identity Manager.
 See also “Important Concepts Related to Directory Integration,” on page 43.
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Active Directory EnvironmentsYou can integrate the service with an Active Directory environment that consists of a single Active Directorydomain, multiple domains in a single Active Directory forest, or multiple domains across multiple ActiveDirectory forests.
 Single Active Directory Domain EnvironmentA single Active Directory deployment allows you to sync users and groups from a single Active Directorydomain.
 For this environment, when you add a directory to the service, select the Active Directory over LDAPoption.
 For more information, see:
 n “About Domain Controller Selection (domain_krb.properties file),” on page 47
 n “Managing User Attributes that Sync from Active Directory,” on page 50
 n “Permissions Required for Joining a Domain,” on page 52
 n “Configuring Active Directory Connection to the Service,” on page 52
 Multi-Domain, Single Forest Active Directory EnvironmentA multi-domain, single forest Active Directory deployment allows you to sync users and groups frommultiple Active Directory domains within a single forest.
 You can configure the service for this Active Directory environment as a single Active Directory, IntegratedWindows Authentication directory type or, alternatively, as an Active Directory over LDAP directory typeconfigured with the global catalog option.
 n The recommended option is to create a single Active Directory, Integrated Windows Authenticationdirectory type.
 When you add a directory for this environment, select the Active Directory (Integrated WindowsAuthentication) option.
 For more information, see:
 n “About Domain Controller Selection (domain_krb.properties file),” on page 47
 n “Managing User Attributes that Sync from Active Directory,” on page 50
 n “Permissions Required for Joining a Domain,” on page 52
 n “Configuring Active Directory Connection to the Service,” on page 52
 n If Integrated Windows Authentication does not work in your Active Directory environment, create anActive Directory over LDAP directory type and select the global catalog option.
 Some of the limitations with selecting the global catalog option include:
 n The Active Directory object attributes that are replicated to the global catalog are identified in theActive Directory schema as the partial attribute set (PAS). Only these attributes are available forattribute mapping by the service. If necessary, edit the schema to add or remove attributes that arestored in the global catalog.
 n The global catalog stores the group membership (the member attribute) of only universal groups.Only universal groups are synced to the service. If necessary, change the scope of a group from alocal domain or global to universal.
 n The bind DN account that you define when configuring a directory in the service must havepermissions to read the Token-Groups-Global-And-Universal (TGGAU) attribute.
 Chapter 4 Integrating with Your Enterprise Directory
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Active Directory uses ports 389 and 636 for standard LDAP queries. For global catalog queries, ports3268 and 3269 are used.
 When you add a directory for the global catalog environment, specify the following during theconfiguration.
 n Select the Active Directory over LDAP option.
 n Deselect the check box for the option This Directory supports DNS Service Location.
 n Select the option This Directory has a Global Catalog. When you select this option, the server portnumber is automatically changed to 3268. Also, because the Base DN is not needed whenconfiguring the global catalog option, the Base DN text box does not display.
 n Add the Active Directory server host name.
 n If your Active Directory requires access over SSL, select the option This Directory requires allconnections to use SSL and paste the certificate in the text box provided. When you select thisoption, the server port number is automatically changed to 3269.
 Multi-Forest Active Directory Environment with Trust RelationshipsA multi-forest Active Directory deployment with trust relationships allows you to sync users and groupsfrom multiple Active Directory domains across forests where two-way trust exists between the domains.
 When you add a directory for this environment, select the Active Directory (Integrated WindowsAuthentication) option.
 For more information, see:
 n “About Domain Controller Selection (domain_krb.properties file),” on page 47
 n “Managing User Attributes that Sync from Active Directory,” on page 50
 n “Permissions Required for Joining a Domain,” on page 52
 n “Configuring Active Directory Connection to the Service,” on page 52
 Multi-Forest Active Directory Environment Without Trust RelationshipsA multi-forest Active Directory deployment without trust relationships allows you to sync users and groupsfrom multiple Active Directory domains across forests without a trust relationship between the domains. Inthis environment, you create multiple directories in the service, one directory for each forest.
 The type of directories you create in the service depends on the forest. For forests with multiple domains,select the Active Directory (Integrated Windows Authentication) option. For a forest with a single domain,select the Active Directory over LDAP option.
 For more information, see:
 n “About Domain Controller Selection (domain_krb.properties file),” on page 47
 n “Managing User Attributes that Sync from Active Directory,” on page 50
 n “Permissions Required for Joining a Domain,” on page 52
 n “Configuring Active Directory Connection to the Service,” on page 52
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About Domain Controller Selection (domain_krb.properties file)The domain_krb.properties file determines which domain controllers are used for directories that have DNSService Location (SRV records) lookup enabled. It contains a list of domain controllers for each domain. Theconnector creates the file initially, and you must maintain it subsequently. The file overrides DNS ServiceLocation (SRV) lookup.
 The following types of directories have DNS Service Location lookup enabled:
 n Active Directory over LDAP with the This Directory supports DNS Service Location option selected
 n Active Directory (Integrated Windows Authentication), which always has DNS Service Location lookupenabled
 When you first create a directory that has DNS Service Location lookup enabled, a domain_krb.propertiesfile is created automatically in the /usr/local/horizon/conf directory of the virtual machine and is auto-populated with domain controllers for each domain. To populate the file, the connector attempts to finddomain controllers that are at the same site as the connector and selects two that are reachable and thatrespond the fastest.
 When you create additional directories that have DNS Service Location enabled, or add new domains to anIntegrated Windows Authentication directory, the new domains, and a list of domain controllers for them,are added to the file.
 You can override the default selection at any time by editing the domain_krb.properties file. As a bestpractice, after you create a directory, view the domain_krb.properties file and verify that the domaincontrollers listed are the optimal ones for your configuration. For a global Active Directory deployment thathas multiple domain controllers across different geographical locations, using a domain controller that is inclose proximity to the connector ensures faster communication with Active Directory.
 You must also update the file manually for any other changes. The following rules apply.
 n The domain_krb.properties file is created in the virtual machine that contains the connector. In a typicaldeployment, with no additional connectors deployed, the file is created in theVMware Identity Manager service virtual machine. If you are using an additional connector for thedirectory, the file is created in the connector virtual machine. A virtual machine can only have onedomain_krb.properties file.
 n The file is created, and auto-populated with domain controllers for each domain, when you first create adirectory that has DNS Service Location lookup enabled.
 n Domain controllers for each domain are listed in order of priority. To connect to Active Directory, theconnector tries the first domain controller in the list. If it is not reachable, it tries the second one in thelist, and so on.
 n The file is updated only when you create a new directory that has DNS Service Location lookup enabledor when you add a domain to an Integrated Windows Authentication directory. The new domain and alist of domain controllers for it are added to the file.
 Note that if an entry for a domain already exists in the file, it is not updated. For example, if you createda directory, then deleted it, the original domain entry remains in the file and is not updated.
 n The file is not updated automatically in any other scenario. For example, if you delete a directory, thedomain entry is not deleted from the file.
 n If a domain controller listed in the file is not reachable, edit the file and remove it.
 n If you add or edit a domain entry manually, your changes will not be overwritten.
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For information on editing the domain_krb.properties file, see “Editing the domain_krb.properties file,” onpage 49.
 Important The /etc/krb5.conf file must be consistent with the domain_krb.properties file. Whenever youupdate the domain_krb.properties file, also update the krb5.conf file. See “Editing thedomain_krb.properties file,” on page 49 and Knowledge Base article 2091744 for more information.
 How Domain Controllers are Selected to Auto-Populate the domain_krb.propertiesFileTo auto-populate the domain_krb.properties file, domain controllers are selected by first determining thesubnet on which the connector resides (based on the IP address and netmask), then using the ActiveDirectory configuration to identify the site of that subnet, getting the list of domain controllers for that site,filtering the list for the appropriate domain, and picking the two domain controllers that respond the fastest.
 To detect the domain controllers that are the closest, VMware Identity Manager has the followingrequirements:
 n The subnet of the connector must be present in the Active Directory configuration, or a subnet must bespecified in the runtime-config.properties file. See “Overriding the Default Subnet Selection,” onpage 48.
 The subnet is used to determine the site.
 n The Active Directory configuration must be site aware.
 If the subnet cannot be determined or if your Active Directory configuration is not site aware, DNS ServiceLocation lookup is used to find domain controllers, and the file is populated with a few domain controllersthat are reachable. Note that these domain controllers may not be at the same geographical location as theconnector, which can result in delays or timeouts while communicating with Active Directory. In this case,edit the domain_krb.properties file manually and specify the correct domain controllers to use for eachdomain. See “Editing the domain_krb.properties file,” on page 49.
 Sample domain_krb.properties Fileexample.com=host1.example.com:389,host2.example.com:389
 Overriding the Default Subnet SelectionTo auto-populate the domain_krb.properties file, the connector attempts to find domain controllers that areat the same site so there is minimal latency between the connector and Active Directory.
 To find the site, the connector determines the subnet on which it resides, based on its IP address andnetmask, then uses the Active Directory configuration to identify the site for that subnet. If the subnet of thevirtual machine is not in Active Directory, or if you want to override the automatic subnet selection, you canspecify a subnet in the runtime-config.properties file.
 Procedure
 1 Log in to the VMware Identity Manager virtual machine as the root user.
 Note If you are using an additional connector for the directory, log in to the connector virtualmachine.
 2 Edit the /usr/local/horizon/conf/runtime-config.properties file to add the following attribute.
 siteaware.subnet.override=subnet
 where subnet is a subnet for the site whose domain controllers you want to use. For example:
 siteaware.subnet.override=10.100.0.0/20
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3 Save and close the file.
 4 Restart the service.
 service horizon-workspace restart
 Editing the domain_krb.properties fileThe /usr/local/horizon/conf/domain_krb.properties file determines the domain controllers to use fordirectories that have DNS Service Location lookup enabled. You can edit the file at any time to modify thelist of domain controllers for a domain, or to add or delete domain entries. Your changes will not beoverridden.
 The file is initially created and auto-populated by the connector. You need to update it manually in scenariossuch as the following:
 n If the domain controllers selected by default are not the optimal ones for your configuration, edit the fileand specify the domain controllers to use.
 n If you delete a directory, delete the corresponding domain entry from the file.
 n If any domain controllers in the file are not reachable, remove them from the file.
 See also “About Domain Controller Selection (domain_krb.properties file),” on page 47.
 Procedure
 1 Log in to the VMware Identity Manager virtual machine as the root user.
 Note If you are using an additional connector for the directory, log in to the connector virtualmachine.
 2 Change directories to /usr/local/horizon/conf.
 3 Edit the domain_krb.properties file to add or edit the list of domain to host values.
 Use the following format:
 domain=host:port,host2:port,host3:port
 For example:
 example.com=examplehost1.example.com:389,examplehost2.example.com:389
 List the domain controllers in order of priority. To connect to Active Directory, the connector tries thefirst domain controller in the list. If it is not reachable, it tries the second one in the list, and so on.
 Important Domain names must be in lowercase.
 4 Change the owner of the domain_krb.properties file to horizon and group to www using the followingcommand.
 chown horizon:www /usr/local/horizon/conf/domain_krb.properties
 5 Restart the service.
 service horizon-workspace restart
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What to do next
 After you edit the domain_krb.properties file, edit the /etc/krb5.conf file. The krb5.conf file must beconsistent with the domain_krb.properties file.
 1 Edit the /etc/krb5.conf file and update the realms section to specify the same domain-to-host valuesthat are used in the /usr/local/horizon/conf/domain_krb.properties file. You do not need to specifythe port number. For example, if your domain_krb.properties file has the domain entryexample.com=examplehost.example.com:389, you would update the krb5.conf file to the following.
 [realms]
 GAUTO-QA.COM = {
 auth_to_local = RULE:[1:$0\$1](^GAUTO-QA\.COM\\.*)s/^GAUTO-QA\.COM/GAUTO-QA/
 auth_to_local = RULE:[1:$0\$1](^GAUTO-QA\.COM\\.*)s/^GAUTO-QA\.COM/GAUTO-QA/
 auth_to_local = RULE:[1:$0\$1](^GAUTO2QA\.GAUTO-QA\.COM\\.*)s/^GAUTO2QA\.GAUTO-
 QA\.COM/GAUTO2QA/
 auth_to_local = RULE:[1:$0\$1](^GLOBEQE\.NET\\.*)s/^GLOBEQE\.NET/GLOBEQE/
 auth_to_local = DEFAULT
 kdc = examplehost.example.com
 }
 Note It is possible to have multiple kdc entries. However, it is not a requirement as in most cases thereis only a single kdc value. If you choose to define additional kdc values, each line will have a kdc entrywhich will define a domain controller.
 2 Restart the workspace service.
 service horizon-workspace restart
 See also Knowledge Base article 2091744.
 Troubleshooting domain_krb.propertiesUse the following information to troubleshoot the domain_krb.properties file.
 "Error resolving domain" error
 If the domain_krb.properties file already includes an entry for a domain, and you try to create a newdirectory of a different type for the same domain, an "Error resolving domain" occurs. You must edit thedomain_krb.properties file and manually remove the domain entry before creating the new directory.
 Domain controllers are unreachable
 Once a domain entry is added to the domain_krb.properties file, it is not updated automatically. If anydomain controllers listed in the file become unreachable, edit the file manually and remove them.
 Managing User Attributes that Sync from Active DirectoryDuring the VMware Identity Manager service directory setup you select Active Directory user attributes andfilters to specify which users sync in the VMware Identity Manager directory. You can change the userattributes that sync from the administration console, Identity & Access Management tab, Setup > UserAttributes.
 Changes that are made and saved in the User Attributes page are added to the Mapped Attributes page inthe VMware Identity Manager directory. The attributes changes are updated to the directory with the nextsync to Active Directory.
 The User Attributes page lists the default directory attributes that can be mapped to Active Directoryattributes. You select the attributes that are required, and you can add other Active Directory attributes thatyou want to sync to the directory. When you add attributes, note that the attribute name you enter is casesensitive. For example, address, Address, and ADDRESS are different attributes.
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Table 4‑1. Default Active Directory Attributes to Sync to Directory
 VMware Identity Manager Directory Attribute Name Default Mapping to Active Directory Attribute
 userPrincipalName userPrincipalName
 distinguishedName distinguishedName
 employeeId employeeID
 domain canonicalName. Adds the fully qualified domain name ofobject.
 disabled (external user disabled) userAccountControl. Flagged with UF_Account_DisableWhen an account is disabled, users cannot log in to access theirapplications and resources. The resources that users wereentitled to are not removed from the account so that when theflag is removed from the account users can log in and accesstheir entitled resources
 phone telephoneNumber
 lastName sn
 firstName givenName
 email mail
 userName sAMAccountName.
 Select Attributes to Sync with DirectoryWhen you set up the VMware Identity Manager directory to sync with Active Directory, you specify the userattributes that sync to the directory. Before you set up the directory, you can specify on the User Attributespage which default attributes are required and add additional attributes that you want to map to ActiveDirectory attributes.
 When you configure the User Attributes page before the directory is created, you can change defaultattributes from required to not required, mark attributes as required, and add custom attributes.
 After the directory is created, you can change a required attribute to not be required, and you can deletecustom attributes. You cannot change an attribute to be a required attribute.
 When you add other attributes to sync to the directory, after the directory is created, go to the directory'sMapped Attributes page to map these attributes to Active Directory Attributes.
 Important If you plan to sync XenApp resources to VMware Identity Manager, you must makedistinguishedName a required attribute. You must specify this before creating theVMware Identity Manager directory.
 Procedure
 1 In the administration console, Identity & Access Management tab, click Setup > User Attributes.
 2 In the Default Attributes section, review the required attribute list and make appropriate changes toreflect what attributes should be required.
 3 In the Attributes section, add the VMware Identity Manager directory attribute name to the list.
 4 Click Save.
 The default attribute status is updated and attributes you added are added on the directory's MappedAttributes list.
 5 After the directory is created, go to the Manage > Directories page and select the directory.
 6 Click Sync Settings > Mapped Attributes.
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7 In the drop-down menu for the attributes that you added, select the Active Directory attribute to mapto.
 8 Click Save.
 The directory is updated the next time the directory syncs to the Active Directory.
 Permissions Required for Joining a DomainYou may need to join the VMware Identity Manager connector to a domain in some cases. For ActiveDirectory over LDAP directories, you can join a domain after creating the directory. For directories of typeActive Directory (Integrated Windows Authentication), the connector is joined to the domain automaticallywhen you create the directory. In both scenarios, you are prompted for credentials.
 To join a domain, you need Active Directory credentials that have the privilege to "join computer to ADdomain". This is configured in Active Directory with the following rights:
 n Create Computer Objects
 n Delete Computer Objects
 When you join a domain, a computer object is created in the default location in Active Directory, unless youspecify a custom OU.
 If you do not have the rights to join a domain, follow these steps to join the domain.
 1 Ask your Active Directory administrator to create the computer object in Active Directory, in a locationdetermined by your company policy. Provide the host name of the connector. Ensure that you providethe fully-qualified domain name, for example, server.example.com.
 Tip You can see the host name in the Host Name column on the Connectors page in the administrationconsole. Click Identity & Access Management > Setup > Connectors to view the Connectors page.
 2 After the computer object is created, join the domain using any domain user account in the VMwareIdentity Manager administration console.
 The Join Domain command is available on the Connectors page, accessed by clicking Identity & AccessManagement > Setup > Connectors.
 Option Description
 Domain Select or enter the Active Directory domain to join. Ensurethat you enter the fully-qualified domain name. Forexample, server.example.com.
 Domain User The username of an Active Directory user who has therights to join systems to the Active Directory domain.
 Domain Password The password of the user.
 Organizational unit (OU) (Optional) The organizational unit (OU) of the computerobject. This option creates a computer object in thespecified OU instead of the default Computers OU.For example, ou=testou,dc=test,dc=example,dc=com.
 Configuring Active Directory Connection to the ServiceIn the administration console, specify the information required to connect to your Active Directory andselect users and groups to sync with the VMware Identity Manager directory.
 The Active Directory connection options are Active Directory over LDAP or Active Directory IntegratedWindows Authentication. Active Directory over LDAP connection supports DNS Service Location lookup.With Active Directory Integrated Windows Authentication, you configure the domain to join.
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Prerequisites
 n Select which attributes are required and add additional attributes, if necessary, on the User Attributespage. See “Select Attributes to Sync with Directory,” on page 51.
 Important If you plan to sync XenApp resources with VMware Identity Manager, you must makedistinguishedName a required attribute. You must make this selection before creating a directory asattributes cannot be changed to be required attributes after a directory is created.
 n List of the Active Directory groups and users to sync from Active Directory.
 n For Active Directory over LDAP, the information required includes the Base DN, Bind DN, and BindDN password.
 Note Using a Bind DN user account with a non-expiring password is recommended.
 n For Active Directory Integrated Windows Authentication, the information required includes thedomain's Bind user UPN address and password.
 Note Using a Bind DN user account with a non-expiring password is recommended.
 n If the Active Directory requires access over SSL or STARTTLS, the Root CA certificate of the ActiveDirectory domain controller is required.
 n For Active Directory Integrated Windows Authentication, when you have multi-forest Active Directoryconfigured and the Domain Local group contains members from domains in different forests, makesure that the Bind user is added to the Administrators group of the domain in which the Domain Localgroup resides. If this is not done, these members are missing from the Domain Local group.
 Procedure
 1 In the administration console, click the Identity & Access Management tab.
 2 On the Directories page, click Add Directory.
 3 Enter a name for this VMware Identity Manager directory.
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4 Select the type of Active Directory in your environment and configure the connection information.
 Option Description
 Active Directory over LDAP a In the Sync Connector field, select the connector to use to sync withActive Directory.
 b In the Authentication field, if this Active Directory is used toauthenticate users, click Yes.
 If a third-party identity provider is used to authenticate users, clickNo. After you configure the Active Directory connection to sync usersand groups, go to the Identity & Access Management > Manage >Identity Providers page to add the third-party identity provider forauthentication.
 c In the Directory Search Attribute field, select the account attribute thatcontains username.
 d If the Active Directory uses DNS Service Location lookup, make thefollowing selections.n In the Server Location section, select the This Directory supports
 DNS Service Location checkbox.
 A domain_krb.properties file, auto-populated with a list ofdomain controllers, will be created when the directory is created.See “About Domain Controller Selection (domain_krb.propertiesfile),” on page 47 .
 n If the Active Directory requires STARTTLS encryption, select theThis Directory requires all connections to use SSL check box inthe Certificates section and copy and paste the Active DirectoryRoot CA certificate into the SSL Certificate field.
 Ensure the certificate is in PEM format and include the "BEGINCERTIFICATE" and "END CERTIFICATE" lines.Note If the Active Directory requires STARTTLS and you do notprovide the certificate, you cannot create the directory.
 e If the Active Directory does not use DNS Service Location lookup,make the following selections.n In the Server Location section, verify that the This Directory
 supports DNS Service Location checkbox is not selected and enterthe Active Directory server host name and port number.
 To configure the directory as a global catalog, see the Multi-Domain, Single Forest Active Directory Environment section in “Active Directory Environments,” on page 45.
 n If the Active Directory requires access over SSL, select the ThisDirectory requires all connections to use SSL check box in theCertificates section and copy and paste the Active Directory RootCA certificate into the SSL Certificate field.
 Ensure the certificate is in PEM format and include the "BEGINCERTIFICATE" and "END CERTIFICATE" lines.Note If the Active Directory requires SSL and you do not providethe certificate, you cannot create the directory.
 f In the Base DN field, enter the DN from which to start accountsearches. For example, OU=myUnit,DC=myCorp,DC=com.
 g In the Bind DN field, enter the account that can search for users. Forexample, CN=binduser,OU=myUnit,DC=myCorp,DC=com.Note Using a Bind DN user account with a non-expiring password isrecommended.
 h After you enter the Bind password, click Test Connection to verify thatthe directory can connect to your Active Directory.
 Active Directory (IntegratedWindows Authentication)
 a In the Sync Connector field, select the connector to use to sync withActive Directory .
 b In the Authentication field, if this Active Directory is used toauthenticate users, click Yes.
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Option DescriptionIf a third-party identity provider is used to authenticate users, clickNo. After you configure the Active Directory connection to sync usersand groups, go to the Identity & Access Management > Manage >Identity Providers page to add the third-party identity provider forauthentication.
 c In the Directory Search Attribute field, select the account attribute thatcontains username.
 d If the Active Directory requires STARTTLS encryption, select the ThisDirectory requires all connections to use STARTTLS checkbox in theCertificates section and copy and paste the Active Directory Root CAcertificate into the SSL Certificate field.
 Ensure the certificate is in PEM format and include the "BEGINCERTIFICATE" and "END CERTIFICATE" lines.
 If the directory has multiple domains, add the Root CA certificates forall domains, one at a time.Note If the Active Directory requires STARTTLS and you do notprovide the certificate, you cannot create the directory.
 e Enter the name of the Active Directory domain to join. Enter a username and password that has the rights to join the domain. See “Permissions Required for Joining a Domain,” on page 52 for moreinformation.
 f In the Bind User UPN field, enter the User Principal Name of the userwho can authenticate with the domain. For example,[email protected] Using a Bind DN user account with a non-expiring password isrecommended.
 g Enter the Bind User password.
 5 Click Save & Next.
 The page with the list of domains appears.
 6 For Active Directory over LDAP, the domains are listed with a check mark.
 For Active Directory (Integrated Windows Authentication), select the domains that should beassociated with this Active Directory connection.
 Note If you add a trusting domain after the directory is created, the service does not automaticallydetect the newly trusting domain. To enable the service to detect the domain, the connector must leaveand then rejoin the domain. When the connector rejoins the domain, the trusting domain appears in thelist.
 Click Next.
 7 Verify that the VMware Identity Manager directory attribute names are mapped to the correct ActiveDirectory attributes and make changes, if necessary, then click Next.
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8 Select the groups you want to sync from Active Directory to the VMware Identity Manager directory.
 Option Description
 Specify the group DNs To select groups, you specify one or more group DNs and select the groupsunder them.a Click + and specify the group DN. For example,
 CN=users,DC=example,DC=company,DC=com.Important Specify group DNs that are under the Base DN that youentered. If a group DN is outside the Base DN, users from that DN willbe synced but will not be able to log in.
 b Click Find Groups.
 The Groups to Sync column lists the number of groups found in theDN.
 c To select all the groups in the DN, click Select All, otherwise clickSelect and select the specific groups to sync.
 Note When you sync a group, any users that do not have Domain Usersas their primary group in Active Directory are not synced.
 Sync nested group members The Sync nested group members option is enabled by default. When thisoption is enabled, all the users that belong directly to the group you selectas well as all the users that belong to nested groups under it are synced.Note that the nested groups are not synced; only the users that belong tothe nested groups are synced. In the VMware Identity Manager directory,these users will be members of the parent group that you selected for sync.If the Sync nested group members option is disabled, when you specify agroup to sync, all the users that belong directly to that group are synced.Users that belong to nested groups under it are not synced. Disabling thisoption is useful for large Active Directory configurations where traversinga group tree is resource and time intensive. If you disable this option,ensure that you select all the groups whose users you want to sync.
 9 Click Next.
 10 Specify additional users to sync, if required.
 a Click + and enter the user DNs. For example,CN=username,CN=Users,OU=myUnit,DC=myCorp,DC=com.
 Important Specify user DNs that are under the Base DN that you entered. If a user DN is outsidethe Base DN, users from that DN will be synced but will not be able to log in.
 b (Optional) To exclude users, create a filter to exclude some types of users.
 You select the user attribute to filter by, the query rule, and the value.
 11 Click Next.
 12 Review the page to see how many users and groups are syncing to the directory and to view the syncschedule.
 To make changes to users and groups, or to the sync frequency, click the Edit links.
 13 Click Sync Directory to start the sync to the directory.
 The connection to Active Directory is established and users and groups are synced from the ActiveDirectory to the VMware Identity Manager directory. The Bind DN user has an administrator role inVMware Identity Manager by default.
 What to do next
 n If you created a directory that supports DNS Service Location, a domain_krb.properties file was createdand auto-populated with a list of domain controllers. View the file to verify or edit the list of domaincontrollers. See “About Domain Controller Selection (domain_krb.properties file),” on page 47.
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n Set up authentication methods. After users and groups sync to the directory, if the connector is alsoused for authentication, you can set up additional authentication methods on the connector. If a thirdparty is the authentication identity provider, configure that identity provider in the connector.
 n Review the default access policy. The default access policy is configured to allow all appliances in allnetwork ranges to access the Web browser, with a session time out set to eight hours or to access a clientapp with a session time out of 2160 hours (90 days). You can change the default access policy and whenyou add Web applications to the catalog, you can create new ones.
 n Apply custom branding to the administration console, user portal pages and the sign-in screen.
 Enabling Users to Change Active Directory PasswordsYou can provide users the ability to change their Active Directory passwords from the Workspace ONEportal or app whenever they want. Users can also reset their Active Directory passwords from theVMware Identity Manager login page if the password has expired or if the Active Directory administratorhas reset the password, forcing the user to change the password at the next login.
 You enable this option per directory, by selecting the Allow Change Password option in the DirectorySettings page.
 Users can change their passwords when they are logged into the Workspace ONE portal by clicking theirname in the top-right corner, selecting Account from the drop-down menu, and clicking the ChangePassword link. In the Workspace ONE app, users can change their passwords by clicking the triple-barmenu icon and selecting Password.
 Expired passwords or passwords reset by the administrator in Active Directory can be changed from thelogin page. When a user tries to log in with an expired password, the user is prompted to reset thepassword. The user must enter the old password as well as the new password.
 The requirements for the new password are determined by the Active Directory password policy. Thenumber of tries allowed also depends on the Active Directory password policy.
 The following limitations apply.
 n If you use additional, standalone connector virtual appliances, note that the Allow Change Passwordoption is only available with connector version 2016.11.1 and later.
 n When a directory is added to VMware Identity Manager as a Global Catalog, the Allow ChangePassword option is not available. Directories can be added as Active Directory over LDAP or IntegratedWindows Authentication, using ports 389 or 636.
 n The password of a Bind DN user cannot be reset from VMware Identity Manager, even if it expires orthe Active Directory administrator resets it.
 Note Using a Bind DN user account with a non-expiring password is recommended.
 n Passwords of users whose login names consist of multibyte characters (non-ASCII characters) cannot bereset from VMware Identity Manager.
 Prerequisites
 n Port 464 must be open from VMware Identity Manager to the domain controllers.
 Procedure
 1 In the administration console, click the Identity & Access Management tab.
 2 In the Directories tab, click the directory.
 3 In the Allow Change Password section, select the Enable change password checkbox.
 4 Enter the Bind DN password in the Bind User Details section, and click Save.
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Integrating with LDAP DirectoriesYou can integrate your enterprise LDAP directory with VMware Identity Manager to sync users and groupsfrom the LDAP directory to the VMware Identity Manager service.
 See also “Important Concepts Related to Directory Integration,” on page 43.
 Limitations of LDAP Directory IntegrationThe following limitations currently apply to the LDAP directory integration feature.
 n You can only integrate a single-domain LDAP directory environment.
 To integrate multiple domains from an LDAP directory, you need to create additionalVMware Identity Manager directories, one for each domain.
 n The following authentication methods are not supported for VMware Identity Manager directories oftype LDAP directory.
 n Kerberos authentication
 n RSA Adaptive Authentication
 n ADFS as a third-party identity provider
 n SecurID
 n Radius authentication with Vasco and SMS Passcode server
 n You cannot join an LDAP domain.
 n Integration with View or Citrix-published resources is not supported for VMware Identity Managerdirectories of type LDAP directory.
 n User names must not contain spaces. If a user name contains a space, the user is synced but entitlementsare not available to the user.
 n If you plan to add both Active Directory and LDAP directories, ensure that you do not mark anyattributes required in the User Attributes page, except for userName, which can be marked required.The settings in the User Attributes page apply to all directories in the service. If an attribute is markedrequired, users without that attribute are not synced to the VMware Identity Manager service.
 n If you have multiple groups with the same name in your LDAP directory, you must specify uniquenames for them in the VMware Identity Manager service. You can specify the names when you selectthe groups to sync.
 n The option to allow users to reset expired passwords is not available.
 n The domain_krb.properties file is not supported.
 Integrate an LDAP Directory with the ServiceYou can integrate your enterprise LDAP directory with VMware Identity Manager to sync users and groupsfrom the LDAP directory to the VMware Identity Manager service.
 To integrate your LDAP directory, you create a corresponding VMware Identity Manager directory and syncusers and groups from your LDAP directory to the VMware Identity Manager directory. You can set up aregular sync schedule for subsequent updates.
 You also select the LDAP attributes that you want to sync for users and map them toVMware Identity Manager attributes.
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Your LDAP directory configuration may be based on default schemas or you may have created customschemas. You may also have defined custom attributes. For VMware Identity Manager to be able to queryyour LDAP directory to obtain user or group objects, you need to provide the LDAP search filters andattribute names that are applicable to your LDAP directory.
 Specifically, you need to provide the following information.
 n LDAP search filters for obtaining groups, users, and the bind user
 n LDAP attribute names for group membership, UUID, and distinguished name
 Certain limitations apply to the LDAP directory integration feature. See “Limitations of LDAP DirectoryIntegration,” on page 58.
 Prerequisites
 n If you use additional, external connector virtual appliances, note that the ability to integrate LDAPdirectories is only available with connector version 2016.6.1 and later.
 n Review the attributes in the Identity & Access Management > Setup > User Attributes page and addadditional attributes that you want to sync. You map these VMware Identity Manager attributes to yourLDAP directory attributes later when you create the directory. These attributes are synced for the usersin the directory.
 Note When you make changes to user attributes, consider the effect on other directories in the service.If you plan to add both Active Directory and LDAP directories, ensure that you do not mark anyattributes required except for userName, which can be marked required. The settings in the UserAttributes page apply to all directories in the service. If an attribute is marked required, users withoutthat attribute are not synced to the VMware Identity Manager service.
 n A Bind DN user account. Using a Bind DN user account with a non-expiring password isrecommended.
 n In your LDAP directory, the UUID of users and groups must be in plain text format.
 n In your LDAP directory, a domain attribute must exist for all users and groups.
 You map this attribute to the VMware Identity Manager domain attribute when you create theVMware Identity Manager directory.
 n User names must not contain spaces. If a user name contains a space, the user is synced but entitlementsare not available to the user.
 n If you use certificate authentication, users must have values for userPrincipalName and email addressattributes.
 Procedure
 1 In the administration console, click the Identity & Access Management tab.
 2 In the Directories page, click Add Directory and select Add LDAP Directory.
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3 Enter the required information in the Add LDAP Directory page.
 Option Description
 Directory Name A name for the VMware Identity Manager directory.
 Directory Sync and Authentication a In the Sync Connector field, select the connector you want to use tosync users and groups from your LDAP directory to theVMware Identity Manager directory.
 A connector component is always available with theVMware Identity Manager service by default. This connector appearsin the drop-down list. If you install multipleVMware Identity Manager appliances for high availability, theconnector component of each appears in the list.
 You do not need a separate connector for an LDAP directory. Aconnector can support multiple directories, regardless of whether theyare Active Directory or LDAP directories.
 For the scenarios in which you need additional connectors, see"Installing Additional Connector Appliances" in the VMware IdentityManager Installation Guide.
 b In the Authentication field, if you want to use this LDAP directory toauthenticate users, select Yes.
 If you want to use a third-party identity provider to authenticate users,select No. After you add the directory connection to sync users andgroups, go to the Identity & Access Management > Manage > IdentityProviders page to add the third-party identity provider forauthentication.
 c In the Directory Search Attribute field, specify the LDAP directoryattribute to be used for user name. If the attribute is not listed, selectCustom and type the attribute name. For example, cn.
 Server Location Enter the LDAP Directory server host and port number. For the serverhost, you can specify either the fully-qualified domain name or the IPaddress. For example, myLDAPserver.example.com or 100.00.00.0.If you have a cluster of servers behind a load balancer, enter the loadbalancer information instead.
 LDAP Configuration Specify the LDAP search filters and attributes thatVMware Identity Manager can use to query your LDAP directory. Defaultvalues are provided based on the core LDAP schema.LDAP Queriesn Get groups: The search filter for obtaining group objects.
 For example: (objectClass=group)n Get bind user: The search filter for obtaining the bind user object, that
 is, the user that can bind to the directory.
 For example: (objectClass=person)n Get user: The search filter for obtaining users to sync.
 For example:(&(objectClass=user)(objectCategory=person))Attributesn Membership: The attribute that is used in your LDAP directory to
 define the members of a group.
 For example: membern Object UUID: The attribute that is used in your LDAP directory to
 define the UUID of a user or group.
 For example: entryUUIDn Distinguished Name: The attribute that is used in your LDAP
 directory for the distinguished name of a user or group.
 For example: entryDN
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Option Description
 Certificates If your LDAP directory requires access over SSL, select the This Directoryrequires all connections to use SSL and copy and paste the LDAPdirectory server's root CA SSL certificate. Ensure the certificate is in PEMformat and include the "BEGIN CERTIFICATE" and "END CERTIFICATE"lines.
 Bind User Details Base DN: Enter the DN from which to start searches. For example,cn=users,dc=example,dc=comBind DN: Enter the user name to use to bind to the LDAP directory.Note Using a Bind DN user account with a non-expiring password isrecommended.Bind DN Password: Enter the password for the Bind DN user.
 4 To test the connection to the LDAP directory server, click Test Connection.
 If the connection is not successful, check the information you entered and make the appropriatechanges.
 5 Click Save & Next.
 6 In the Domains page, verify that the correct domain is listed, then click Next.
 7 In the Map Attributes page, verify that the VMware Identity Manager attributes are mapped to thecorrect LDAP attributes.
 Important You must specify a mapping for the domain attribute.
 You can add attributes to the list from the User Attributes page.
 8 Click Next.
 9 In the groups page, click + to select the groups you want to sync from the LDAP directory to theVMware Identity Manager directory.
 If you have multiple groups with the same name in your LDAP directory, you must specify uniquenames for them in the groups page.
 The Sync nested group users option is enabled by default. When this option is enabled, all the usersthat belong directly to the group you select as well as all the users that belong to nested groups under itare synced. Note that the nested groups are not synced; only the users that belong to the nested groupsare synced. In the VMware Identity Manager directory, these users will appear as members of the top-level group that you selected for sync. In effect, the hierarchy under a selected group is flattened andusers from all levels appear in VMware Identity Manager as members of the selected group.
 If this option is disabled, when you specify a group to sync, all the users that belong directly to thatgroup are synced. Users that belong to nested groups under it are not synced. Disabling this option isuseful for large directory configurations where traversing a group tree is resource and time intensive. Ifyou disable this option, ensure that you select all the groups whose users you want to sync.
 10 Click Next.
 11 Click + to add additional users. For example, enter CN=username,CN=Users,OU=myUnit,DC=myCorp,DC=com.
 To exclude users, create a filter to exclude some types of users. You select the user attribute to filter by,the query rule, and the value.
 Click Next.
 12 Review the page to see how many users and groups will sync to the directory and to view the defaultsync schedule.
 To make changes to users and groups, or to the sync frequency, click the Edit links.
 13 Click Sync Directory to start the directory sync.
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The connection to the LDAP directory is established and users and groups are synced from the LDAPdirectory to the VMware Identity Manager directory. The Bind DN user has an administrator role inVMware Identity Manager by default.
 Adding a Directory After Configuring Failover and RedundancyIf you add a new directory to the VMware Identity Manager service after you have already deployed acluster for high availability, and you want to make the new directory part of the high availabilityconfiguration, you need to add the directory to all the appliances in your cluster.
 You do this by adding the connector component of each of the service instances to the new directory.
 Procedure
 1 Log in to the VMware Identity Manager administration console.
 2 Select the Identity & Access Management tab, then select the Identity Providers tab.
 3 In the Identity Providers page, find the identity provider for the new directory and click the identityprovider name.
 4 In the IdP Hostname field, enter the load balancer FQDN, if it is not already set to the correct loadbalancer FQDN.
 5 In the Connector(s) field, select the connector to add.
 6 Enter the password and click Save.
 7 In the Identity Providers page, click the Identity Provider name again and verify that the IdP Hostnamefield displays the correct host name. The IdP Hostname field should display the load balancer FQDN. Ifthe name is incorrect, enter the load balancer FQDN and click Save.
 8 Repeat the preceding steps to add all the connectors listed in the Connector(s) field.
 Note After you add each connector, check the IdP host name and modify it, if necessary, as describedin step 7.
 The directory is now associated with all the connectors in your deployment.
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Using Local Directories 5A local directory is one of the types of directories that you can create in the VMware Identity Managerservice. A local directory enables you to provision local users in the service and provide them access tospecific applications, without having to add them to your enterprise directory. A local directory is notconnected to an enterprise directory and users and groups are not synced from an enterprise directory.Instead, you create local users directly in the local directory.
 A default local directory, named System Directory, is available in the service. You can also create multiplenew local directories.
 System DirectoryThe System Directory is a local directory that is automatically created in the service when it is first set up.This directory has the domain System Domain. You cannot change the name or domain of the SystemDirectory, or add new domains to it. Nor can you delete the System Directory or the System Domain.
 The local administrator user that is created when you first set up the VMware Identity Manager appliance iscreated in the System Domain of the System Directory.
 You can add other users to the System Directory. The System Directory is typically used to set up a few localadministrator users to manage the service. To provision end users and additional administrators and entitlethem to applications, creating a new local directory is recommended.
 Local DirectoriesYou can create multiple local directories. Each local directory can have one or more domains. When youcreate a local user, you specify the directory and domain for the user.
 You can also select attributes for all the users in a local directory. User attributes such as userName,lastName, and firstName are specified at the global level in the VMware Identity Manager service. A defaultlist of attributes is available and you can add custom attributes. Global user attributes apply to all directoriesin the service, including local directories. At the local directory level, you can select which attributes arerequired for the directory. This allows you to have a custom set of attributes for different local directories.Note that userName, lastName, firstName, and email are always required for local directories.
 Note The ability to customize user attributes at the directory level is only available for local directories, notfor Active Directory or LDAP directories.
 Creating local directories is useful in scenarios such as the following.
 n You can create a local directory for a specific type of user that is not part of your enterprise directory.For example, you can create a local directory for partners, who are not usually part of your enterprisedirectory, and provide them access to only the specific applications they need.
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n You can create multiple local directories if you want different user attributes or authentication methodsfor different sets of users. For example, you can create a local directory for distributors that has userattributes such as region and market size, and another local directory for suppliers that has userattributes such as product category and supplier type.
 Identity Provider for System Directory and Local DirectoriesBy default, the System Directory is associated with an identity provider named System Identity Provider.The Password (Cloud Directory) method is enabled by default on this identity provider and applies to thedefault_access_policy_set policy for the ALL RANGES network range and the Web Browser device type.You can configure additional authentication methods and set authentication policies.
 When you create a new local directory, it is not associated with any identity provider. After creating thedirectory, create a new identity provider of type Embedded and associate the directory with it. Enable thePassword (Cloud Directory) authentication method on the identity provider. Multiple local directories canbe associated with the same identity provider.
 The VMware Identity Manager connector is not required for either the System Directory or for localdirectories you create.
 For more information, see "Configuring User Authentication in VMware Identity Manager" in VMwareIdentity Manager Administration.
 Password Management for Local Directory UsersBy default, all users of local directories have the ability to change their password in the Workspace ONEportal or app. You can set a password policy for local users. You can also reset local user passwords asneeded.
 Users can change their passwords when they are logged into the Workspace ONE portal by clicking theirname in the top-right corner, selecting Account from the drop-down menu, and clicking the ChangePassword link. In the Workspace ONE app, users can change their passwords by clicking the triple-barmenu icon and selecting Password.
 For information on setting password policies and resetting local user passwords, see "Managing Users andGroups" in VMware Identity Manager Administration.
 This chapter includes the following topics:
 n “Creating a Local Directory,” on page 64
 n “Changing Local Directory Settings,” on page 69
 n “Deleting a Local Directory,” on page 70
 Creating a Local DirectoryTo create a local directory, you specify the user attributes for the directory, create the directory, and identifyit with an identity provider.
 1 Set User Attributes at the Global Level on page 65Before you create a local directory, review the global user attributes on the User Attributes page andadd custom attributes, if necessary.
 2 Create a Local Directory on page 66After you review and set global user attributes, create the local directory.
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3 Associate the Local Directory With an Identity Provider on page 68Associate the local directory with an identity provider so that users in the directory can beauthenticated. Create a new identity provider of type Embedded and enable the Password (LocalDirectory) authentication method on it.
 Set User Attributes at the Global LevelBefore you create a local directory, review the global user attributes on the User Attributes page and addcustom attributes, if necessary.
 User attributes, such as firstName, lastName, email and domain, are part of a user's profile. In theVMware Identity Manager service, user attributes are defined at the global level and apply to all directoriesin the service, including local directories. At the local directory level, you can override whether an attributeis required or optional for users in that local directory, but you cannot add custom attributes. If an attributeis required, you must provide a value for it when you create a user.
 The following words cannot be used when you create custom attributes.
 Table 5‑1. Words that cannot be used as Custom Attribute Names
 active addresses costCenter
 department displayName division
 emails employeeNumber entitlements
 externalId groups id
 ims locale manager
 meta name nickName
 organization password phoneNumber
 photos preferredLanguage profileUrl
 roles timezone title
 userName userType x509Certificate
 Note The ability to override user attributes at the directory level only applies to local directories, not toActive Directory or LDAP directories.
 Procedure
 1 In the administration console, click the Identity & Access Management tab.
 2 Click Setup, then click the User Attributes tab.
 3 Review the list of user attributes and add additional attributes, if necessary.
 Note Although this page lets you select which attributes are required, it is recommended that youmake the selection for local directories at the local directory level. If an attribute is marked required onthis page, it applies to all directories in the service, including Active Directory or LDAP directories.
 4 Click Save.
 What to do next
 Create the local directory.
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Create a Local DirectoryAfter you review and set global user attributes, create the local directory.
 Procedure
 1 In the administration console, click the Identity & Access Management tab, then click the Directoriestab
 2 Click Add Directory and select Add Local User Directory from the drop-down menu.
 3 In the Add Directory page, enter a directory name and specify at least one domain name.
 The domain name must be unique across all directories in the service.
 For example:
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4 Click Save.
 5 In the Directories page, click the new directory.
 6 Click the User Attributes tab.
 All the attributes from the Identity & Access Management > Setup > User Attributes page are listed forthe local directory. Attributes that are marked required on that page are listed as required in the localdirectory page too.
 7 Customize the attributes for the local directory.
 You can specify which attributes are required and which attributes are optional. You can also change theorder in which the attributes appear.
 Important The attributes userName, firstName, lastName, and email are always required for localdirectories.
 n To make an attribute required, select the check box next to the attribute name.
 n To make an attribute optional, deselect the check box next to the attribute name.
 n To change the order of the attributes, click and drag the attribute to the new position.If an attribute is required, when you create a user you must specify a value for the attribute.
 For example:
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8 Click Save.
 What to do next
 Associate the local directory with the identity provider you want to use to authenticate users in thedirectory.
 Associate the Local Directory With an Identity ProviderAssociate the local directory with an identity provider so that users in the directory can be authenticated.Create a new identity provider of type Embedded and enable the Password (Local Directory) authenticationmethod on it.
 Note Do not use the Built-in identity provider. Enabling the Password (Local Directory) authenticationmethod on the Built-in identity provider is not recommended.
 Procedure
 1 In the Identity & Access Management tab, click the Identity Providers tab.
 2 Click Add Identity Provider and select Create Built-in IDP.
 3 Enter the following information.
 Option Description
 Identity Provider Name Enter a name for the identity provider.
 Users Select the local directory you created.
 Network Select the networks from which this identity provider can be accessed.
 Authentication Methods Select Password (Local Directory).
 KDC Certificate Export You do not need to download the certificate unless you are configuringmobile SSO for AirWatch-managed iOS devices.
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4 Click Add.
 The identity provider is created and associated with the local directory. Later, you can configure otherauthentication methods on the identity provider. For more information about authentication, see"Configuring User Authentication in VMware Identity Manager" in VMware Identity Manager Administration.
 You can use the same identity provider for multiple local directories.
 What to do next
 Create local users and groups. You create local users and groups in the Users & Groups tab in theadministration console. See "Managing Users and Groups" in VMware Identity Manager Administration formore information.
 Changing Local Directory SettingsAfter you create a local directory, you can modify its settings at any time.
 You can change the following settings.
 n Change the directory name.
 n Add, delete, or rename domains.
 n Domain names must be unique across all directories in the service.
 n When you change a domain name, the users that were associated with the old domain areassociated with the new domain.
 n The directory must have at least one domain.
 n You cannot add a domain to the System Directory or delete the System Domain.
 n Add new user attributes or make an existing attribute required or optional.
 n If the local directory does not have any users yet, you can add new attributes as either optional orrequired, and change existing attributes to required or optional.
 n If you have already created users in the local directory, you can add new attributes as optionalattributes only, and change existing attributes from required to optional. You cannot make anoptional attribute required after users have been created.
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n The attributes userName, firstName, lastName, and email are always required for local directories.
 n As user attributes are defined at the global level in the VMware Identity Manager service, any newattributes you add will appear in all directories in the service.
 n Change the order in which attributes appear.
 Procedure
 1 Click the Identity & Access Management tab.
 2 In the Directories page, click the directory you want to edit.
 3 Edit the local directory settings.
 Option Action
 Change the directory name a In the Settings tab, edit the directory name.b Click Save.
 Add, delete, or rename a domain a In the Settings tab, edit the Domains list.b To add a domain, click the green plus icon.c To delete a domain, click the red delete icon.d To rename a domain, edit the domain name in the text box.
 Add user attributes to the directory a Click the Identity & Access Management tab, then click Setup.b Click the User Attributes tab.c Add attributes in the Add other attributes to use list, and click Save.
 Make an attribute required oroptional for the directory
 a In the Identity & Access Management tab, click the Directories tab.b Click the local directory name and click the User Attributes tab.c Select the check box next to an attribute to make it a required attribute,
 or deselect the check box to make it an optional attribute.d Click Save.
 Change the order of the attributes a In the Identity & Access Management tab, click the Directories tab.b Click the local directory name and click the User Attributes tab.c Click and drag the attributes to the new position.d Click Save.
 Deleting a Local DirectoryYou can delete a local directory that you created in the VMware Identity Manager service. You cannot deletethe System Directory, which is created by default when you first set up the service.
 Caution When you delete a directory, all users in the directory are also deleted from the service.
 Procedure
 1 Click the Identity & Access Management tab, then click the Directories tab.
 2 Click the directory you want to delete.
 3 In the directory page, click Delete Directory.
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Advanced Configuration for theVMware Identity Manager Appliance 6
 After you complete the basic VMware Identity Manager virtual appliance installation, you might need tocomplete other configuration tasks such as enabling external access to the VMware Identity Manager andconfiguring redundancy.
 The VMware Identity Manager architecture diagram demonstrates how you can deploy theVMware Identity Manager environment. See Chapter 1, “Preparing to Install VMware Identity Manager,”on page 9 for a typical deployment.
 This chapter includes the following topics:
 n “Using a Load Balancer or Reverse Proxy to Enable External Access to VMware Identity Manager,” onpage 71
 n “Configuring Failover and Redundancy in a Single Datacenter,” on page 75
 n “Deploying VMware Identity Manager in a Secondary Data Center for Failover and Redundancy,” onpage 80
 Using a Load Balancer or Reverse Proxy to Enable External Access toVMware Identity Manager
 During deployment, the VMware Identity Manager virtual appliance is set up inside the internal network. Ifyou want to provide access to the service for users connecting from outside networks, you must install aload balancer or a reverse proxy, such as Apache, nginx, or F5, in the DMZ.
 If you do not use a load balancer or reverse proxy, you cannot expand the number ofVMware Identity Manager appliances later. You might need to add more appliances to provide redundancyand load balancing. The following diagram shows the basic deployment architecture you can use to enableexternal access.
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Figure 6‑1. External Load Balancer Proxy with Virtual Machine
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 Internal users
 External users
 DMZ Firewall
 Port 443 Port 443
 VMware Identity Manager
 Internal Load BalancerHostname: VMware Identity Manager FQDNExample IP address: 10..x.y.zPort: VMware Identity Manager portMust enable X-Forwarded-For headers.
 External Load BalancerHostname: VMware Identity Manager FQDNExample IP address: 64.x.y.zPort: VMware Identity Manager portMust enable X-Forwarded-For headers.
 Virtual Appliance
 Virtual Appliance
 Virtual Appliance
 Specify VMware Identity Manager FQDN during DeploymentDuring the deployment of the VMware Identity Manager virtual machine, you enter theVMware Identity Manager FQDN and port number. These values must point to the host name that you wantend users to access.
 The VMware Identity Manager virtual machine always runs on port 443. You can use a different portnumber for the load balancer. If you use a different port number, you must specify it during deployment.
 Load Balancer Settings to ConfigureLoad balancer settings to configure include enabling X-Forwarded-For headers, setting the load balancertimeout correctly, and enabling sticky sessions. In addition, SSL trust must be configured between theVMware Identity Manager virtual appliance and the load balancer.
 n X-Forwarded-For Headers
 You must enable X-Forwarded-For headers on your load balancer. This determines the authenticationmethod. See the documentation provided by your load balancer vendor for more information.
 n Load Balancer Timeout
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For VMware Identity Manager to function correctly, you might need to increase the load balancerrequest timeout from the default. The value is set in minutes. If the timeout setting is too low, you mightsee this error, “502 error: The service is currently unavailable.”
 n Enable Sticky Sessions
 You must enable the sticky session setting on the load balancer if your deployment has multipleVMware Identity Manager appliances. The load balancer will then bind a user's session to a specificinstance.
 Apply VMware Identity Manager Root Certificate to the Load BalancerWhen the VMware Identity Manager virtual appliance is configured with a load balancer, you mustestablish SSL trust between the load balancer and VMware Identity Manager. TheVMware Identity Manager root certificate must be copied to the load balancer.
 The VMware Identity Manager certificate can be downloaded from the administration console, from theAppliance Settings > VA Configuration > Manage Configuration page.
 If the VMware Identity Manager FQDN points to a load balancer, the SSL certificate can only be applied tothe load balancer.
 Since the load balancer communicates with the VMware Identity Manager virtual appliance, you must copythe VMware Identity Manager root CA certificate to the load balancer as a trusted root certificate.
 Procedure
 1 In the administration console, select the Appliance Settings tab and select VA Configuration.
 2 Click Manage Configuration.
 3 Select Install Certificate.
 4 Select the Terminate SSL on a Load Balancer tab and in the Appliance Root CA Certificate field, clickthe link https://hostname/horizon_workspace_rootca.pem.
 5 Copy everything between and including the lines -----BEGIN CERTIFICATE----- and -----END
 CERTIFICATE---- and paste the root certificate into the correct location on each of your load balancers.Refer to the documentation provided by your load balancer vendor.
 What to do next
 Copy and paste the load balancer root certificate to the VMware Identity Managerconnector appliance.
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Apply Load Balancer Root Certificate to VMware Identity ManagerWhen the VMware Identity Manager virtual appliance is configured with a load balancer, you mustestablish trust between the load balancer and VMware Identity Manager. In addition to copying theVMware Identity Manager root certificate to the load balancer, you must copy the load balancer rootcertificate to VMware Identity Manager.
 Procedure
 1 Obtain the load balancer root certificate.
 2 In the VMware Identity Manager administration console, select the Appliance Settings tab and selectVA Configuration.
 3 Click Manage Configuration.
 4 Log in with the admin user password.
 5 In the Install Certificate page, select the Terminate SSL on a Load Balancer tab.
 6 Paste the text of the load balancer certificate into the Root CA Certificate field.
 7 Click Save.
 Setting Proxy Server Settings for VMware Identity ManagerThe VMware Identity Manager virtual appliance accesses the cloud application catalog and other Webservices on the Internet. If your network configuration provides Internet access through an HTTP proxy, youmust adjust your proxy settings on the VMware Identity Manager appliance.
 Enable your proxy to handle only Internet traffic. To ensure that the proxy is set up correctly, set theparameter for internal traffic to no-proxy within the domain.
 Note Proxy servers that require authentication are not supported.
 Procedure
 1 From the vSphere Client, log in as the root user to the VMware Identity Manager virtual appliance.
 2 Enter YaST on the command line to run the YaST utility.
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3 Select Network Services in the left pane, then select Proxy.
 4 Enter the proxy server URLs in the HTTP Proxy URL and HTTPS Proxy URL fields.
 5 Select Finish and exit the YaST utility.
 6 Restart the Tomcat server on the VMware Identity Manager virtual appliance to use the new proxysettings.
 service horizon-workspace restart
 The cloud application catalog and other Web services are now available in VMware Identity Manager.
 Configuring Failover and Redundancy in a Single DatacenterTo achieve failover and redundancy, you can add multiple VMware Identity Manager virtual appliances in acluster. If one of the virtual appliances shuts down for any reason, VMware Identity Manager is stillavailable.
 You first install and configure a VMware Identity Manager virtual appliance, then you clone it. Cloning thevirtual appliance creates a duplicate of the appliance with the same configuration as the original. You cancustomize the cloned virtual appliance to change the name, network settings, and other properties asrequired.
 Before you clone the VMware Identity Manager virtual appliance, you must configure it behind a loadbalancer and change its Fully Qualified Domain Name (FQDN) to match the load balancer FQDN. Also,complete directory configuration in the VMware Identity Manager service before you clone the appliance.
 After cloning, you assign the cloned virtual appliance a new IP address before powering it on. The clonedvirtual appliance IP address must follow the same guidelines as the IP address of the original virtualappliance. The IP address must resolve to a valid host name using forward and reverse DNS.
 All nodes in the VMware Identity Manager cluster are identical and nearly stateless copies of each other.Syncing to Active Directory and to resources that are configured, such as View or ThinApp, is disabled onthe cloned virtual appliances.
 1 Recommended Number of Nodes in VMware Identity Manager Cluster on page 75Setting up a VMware Identity Manager cluster with three nodes is recommended.
 2 Change VMware Identity Manager FQDN to Load Balancer FQDN on page 76Before you clone the VMware Identity Manager virtual appliance, you must change its Fully QualifiedDomain Name (FQDN) to match the load balancer FQDN.
 3 Clone the Virtual Appliance on page 77
 4 Assign a New IP Address to Cloned Virtual Appliance on page 78You must assign a new IP address to each cloned virtual appliance before you power it on. The IPaddress must be resolvable in DNS. If the address is not in the reverse DNS, you must also assign thehost name.
 5 Enabling Directory Sync on Another Instance in the Event of a Failure on page 79
 Recommended Number of Nodes in VMware Identity Manager ClusterSetting up a VMware Identity Manager cluster with three nodes is recommended.
 The VMware Identity Manager appliance includes Elasticsearch, a search and analytics engine. Elasticsearchhas a known limitation with clusters of two nodes. For a description of the Elasticsearch "split brain"limitation, see the Elasticsearch documentation. Note that you do not have to configure any Elasticsearchsettings.
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A VMware Identity Manager cluster with two nodes provides failover capability with a few limitationsrelated to Elasticsearch. If one of the nodes shuts down, the following limitations apply until the node isbrought up again:
 n The dashboard does not display data.
 n Most reports are unavailable.
 n Sync log information is not displayed for directories.
 n The search field in the top-right corner of the administration console does not return any results.
 n Auto-complete is not available for text fields.
 There is no data loss during the time the node is down. Audit event and sync log data is stored and will bedisplayed when the node is restored.
 Change VMware Identity Manager FQDN to Load Balancer FQDNBefore you clone the VMware Identity Manager virtual appliance, you must change its Fully QualifiedDomain Name (FQDN) to match the load balancer FQDN.
 Prerequisites
 n The VMware Identity Manager appliance is added to a load balancer.
 n You have applied the load balancer root CA certificate to VMware Identity Manager.
 Procedure
 1 Log in to the VMware Identity Manager administration console.
 2 Select the Appliance Settings tab.
 3 In the Virtual Appliance Configuration page, click Manage Configuration.
 4 Enter your administrator password to log in.
 5 Click Identity Manager Configuration.
 6 In the Identity Manager FQDN field, change the host name part of the URL from theVMware Identity Manager host name to the load balancer host name.
 For example, if your VMware Identity Manager host name is myservice and your load balancer hostname is mylb, you would change the URL
 https://myservice.mycompany.com
 to the following:
 https://mylb.mycompany.com
 7 Click Save.
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n The service FQDN is changed to the load balancer FQDN.
 n The Identity Provider URL is changed to the load balancer URL.
 What to do next
 Clone the virtual appliance.
 Clone the Virtual ApplianceClone the VMware Identity Manager virtual appliance to create multiple virtual appliances of the same typeto distribute traffic and eliminate potential downtime.
 Using multiple VMware Identity Manager virtual appliances improves availability, load balances requests tothe service, and decreases response times to the end user.
 Prerequisites
 n The VMware Identity Manager virtual appliance must be configured behind a load balancer. Make surethat the load balancer port is 443. Do not use 8443 as this port number is the administrative port and isunique to each virtual appliance.
 n An external database is configured as described in “Connecting to the Database,” on page 32.
 n Ensure that you complete directory configuration in VMware Identity Manager.
 n Log in to the virtual appliance console as root and delete the /etc/udev/rules.d/70-persistent-net.rules file, if it exists. If you do not delete this file before cloning, networking is not configuredcorrectly on the cloned virtual appliance.
 Procedure
 1 Log in to the vSphere Client or vSphere Web Client and navigate to the VMware Identity Managervirtual appliance.
 2 Right-click the virtual appliance and select Clone.
 3 Enter the name for the cloned virtual appliance and click Next.
 The name must be unique within the VM folder.
 4 Select the host or cluster on which to run the cloned virtual appliance and click Next.
 5 Select the resource pool in which to run the virtual appliance and click Next.
 6 For the virtual disk format, select Same format as source.
 7 Select the data store location where you want to store the virtual appliance files and click Next.
 8 Select Do not customize as the guest operating system option.
 9 Review the options and click Finish.
 The cloned virtual appliance is deployed. You cannot use or edit the virtual appliance until the cloning iscomplete.
 What to do next
 Assign an IP address to the cloned virtual appliance before you power it on and add it to the load balancer.
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Assign a New IP Address to Cloned Virtual ApplianceYou must assign a new IP address to each cloned virtual appliance before you power it on. The IP addressmust be resolvable in DNS. If the address is not in the reverse DNS, you must also assign the host name.
 Procedure
 1 In the vSphere Client or the vSphere Web Client, select the cloned virtual appliance.
 2 In the Summary tab, under Commands, click Edit Settings.
 3 Select Options and in the vApp Options list, select Properties.
 4 Change the IP address in the IP Address field.
 5 If the IP address is not in the reverse DNS, add the host name in the HostName text box.
 6 Click OK.
 7 Power on the cloned appliance and wait until the blue login screen appears in the Console tab.
 Important Before you power on the cloned appliance, ensure that the original appliance is fullypowered on.
 What to do next
 n Wait for a few minutes until the Elasticsearch and RabbitMQ clusters are created before adding thecloned virtual appliance to the load balancer.
 Elasticsearch, a search and analytics engine, and RabbitMQ, a messaging broker, are embedded in thevirtual appliance.
 a Log in to the cloned virtual appliance.
 b Check the Elasticsearch cluster:
 curl -XGET 'http://localhost:9200/_cluster/health?pretty=true'
 Verify that the result matches the number of nodes.
 c Check the RabbitMQ cluster:
 rabbitmqctl cluster_status
 Verify that the result matches the number of nodes.
 n Add the cloned virtual appliance to the load balancer and configure the load balancer to distributetraffic. See your load balancer vendor documentation for information.
 n If you had joined a domain in the original service instance, then you need to join the domain in thecloned service instances.
 a Log in to the VMware Identity Manager administration console.
 b Select the Identity & Access Management tab, then click Setup.
 The connector component of each of the cloned service instances is listed in the Connectors page.
 c For each connector listed, click Join Domain and specify the domain information.
 For more information about Active Directory, see “Integrating with Active Directory,” on page 44.
 n For directories of type Integrated Windows Authentication (IWA), you must do the following:
 a For the cloned service instances, join the domain to which the IWA directory in the original serviceinstance was joined.
 1 Log in to the VMware Identity Manager administration console.
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2 Select the Identity & Access Management tab, then click Setup.
 The connector component of each of the cloned service instances is listed in the Connectorspage.
 3 For each connector listed, click Join Domain and specify the domain information.
 b Save the IWA directory configuration.
 1 Select the Identity & Access Management tab.
 2 In the Directories page, click the IWA directory link.
 3 Click Save to save the directory configuration.
 n If you had manually updated the /etc/krb5.conf file in the original service instance, for example, toresolve View synchronization failure or slowness, you must update the file in the cloned instance afterthe cloned instance is joined to the domain. In all the cloned service instances, perform the followingtasks.
 a Edit the /etc/krb5.conf file and update the realms section to specify the same domain-to-hostvalues that are used in the /usr/local/horizon/conf/domain_krb.properties file. You do not needto specify the port number. For example, if your domain_krb.properties file has the domain entryexample.com=examplehost.example.com:389, you would update the krb5.conf file to the following.
 [realms]
 GAUTO-QA.COM = {
 auth_to_local = RULE:[1:$0\$1](^GAUTO-QA\.COM\\.*)s/^GAUTO-QA\.COM/GAUTO-QA/
 auth_to_local = RULE:[1:$0\$1](^GAUTO-QA\.COM\\.*)s/^GAUTO-QA\.COM/GAUTO-QA/
 auth_to_local = RULE:[1:$0\$1](^GAUTO2QA\.GAUTO-QA\.COM\\.*)s/^GAUTO2QA\.GAUTO-
 QA\.COM/GAUTO2QA/
 auth_to_local = RULE:[1:$0\$1](^GLOBEQE\.NET\\.*)s/^GLOBEQE\.NET/GLOBEQE/
 auth_to_local = DEFAULT
 kdc = examplehost.example.com
 }
 Note It is possible to have multiple kdc entries. However, it is not a requirement as in most casesthere is only a single kdc value. If you choose to define additional kdc values, each line will have akdc entry which will define a domain controller.
 b Restart the workspace service.
 service horizon-workspace restart
 Note Also see Knowledge Base article 2091744.
 n Enable the authentication methods configured for connector on each of the cloned instances. See theVMware Identity Manager Administration Guide for information.
 The VMware Identity Manager service virtual appliance is now highly available. Traffic is distributed to thevirtual appliances in your cluster based on the load balancer configuration. Authentication to the service ishighly available. For the directory sync feature of the service, however, in the event of a service instancefailure, you will need to manually enable directory sync on a cloned service instance. Directory sync ishandled by the connector component of the service and can only be enabled on one connector at a time. See “Enabling Directory Sync on Another Instance in the Event of a Failure,” on page 79.
 Enabling Directory Sync on Another Instance in the Event of a FailureIn the event of a service instance failure, authentication is handled automatically by a cloned instance, asconfigured in the load balancer. However, for directory sync, you need to modify the directory settings inthe VMware Identity Manager service to use a cloned instance. Directory sync is handled by the connectorcomponent of the service and can only be enabled on one connector at a time.
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Procedure
 1 Log in to the VMware Identity Manager administration console.
 2 Click the Identity & Access Management tab, then click Directories.
 3 Click the directory that was associated with the original service instance.
 You can view this information in the Setup > Connectors page. The page lists the connector componentof each of the service virtual appliances in your cluster.
 4 In the Directory Sync and Authentication section of the directory page, in the Sync Connector field,select one of the other connectors.
 5 In the Bind DN Password field, enter your Active Directory bind account password.
 6 Click Save.
 Deploying VMware Identity Manager in a Secondary Data Center forFailover and Redundancy
 To provide failover capabilities if the primary VMware Identity Manager data center becomes unavailable,VMware Identity Manager needs to be deployed in a secondary data center.
 By using a secondary data center, end users can log in and use applications with no downtime. A secondarydata center also allows administrators the ability to upgrade VMware Identity Manager to the next versionwithout any downtime. See “Upgrading VMware Identity Manager with No Downtime,” on page 91.
 A typical deployment using a secondary data center is shown here.
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 Follow these guidelines for a multi-data center deployment.
 n Cluster Deployment: You need to deploy a set of three or more VMware Identity Manager virtualappliances as one cluster in one data center and another set of three or more virtual appliances asanother cluster in the second data center. See “Setting up a Secondary Data Center,” on page 82 formore information.
 n Database: VMware Identity Manager uses the database to store data. For a multi-datacenterdeployment, replication of the database between the two data centers is crucial. Refer to your databasedocumentation about how to set up a database in multiple data centers. For example, with SQL Server,using Always On deployment is recommended. See Overview of Always On Availability Groups (SQLServer) on the Microsoft website for information. VMware Identity Manager functionalities expect verylow latency between the database and the VMware Identity Manager appliance. Therefore, appliancesin one data center are expected to connect to the database in the same data center.
 n Not Active-Active: VMware Identity Manager does not support an Active-Active deployment whereusers can be served from both data centers at the same time. The secondary data center is a hot stand-byand can be used to provide business continuity for end users. VMware Identity Manager appliances inthe secondary data center are in a read-only mode. Therefore, after a fail-over to that data center, mostadmin operations, like adding users or apps, or entitling users, will not work.
 n Fail-Back to Primary: In most failure scenarios, you can fail back to the primary data center once thatdata center is back to normal. See “Failback to Primary Data Center,” on page 91 for information.
 Chapter 6 Advanced Configuration for the VMware Identity Manager Appliance
 VMware, Inc. 81
 https://msdn.microsoft.com/en-us/library/ff877884.aspx
 https://msdn.microsoft.com/en-us/library/ff877884.aspx

Page 82
                        
                        

n Promote Secondary to Primary: In case of an extended data center failure, the secondary data center canbe promoted to primary. See “Promoting Secondary Data Center to Primary Data Center,” on page 91for information.
 n Fully Qualified Domain Name: The fully qualified domain name to access VMware Identity Managershould be the same in all data centers.
 n Audits: VMware Identity Manager uses Elasticsearch embedded in the VMware Identity Managerappliance for auditing, reports, and directory sync logs. Separate Elasticsearch clusters have to becreated in each data center. See “Setting up a Secondary Data Center,” on page 82 for moreinformation.
 n Active Directory: VMware Identity Manager can connect to Active Directory using the LDAP API orusing Integrated Windows Authentication. In both these methods, VMware Identity Manager canleverage Active Directory SRV records to reach the appropriate domain controller in each data center.
 n Windows Apps: VMware Identity Manager supports accessing Windows apps using ThinApp, andWindows Apps and Desktops using Horizon View or Citrix technologies. It is usually important todeliver these resources from a data center that is closer to the user, also called Geo-Affinity. Note thefollowing about Windows resources:
 n ThinApps - VMware Identity Manager supports Windows Distributed File Systems as a ThinApprepository. Use the Windows Distributed File Systems documentation to set up appropriatelocation-specific policies.
 n Horizon View (with Cloud Pod Architecture) - VMware Identity Manager supports Horizon CloudPod Architecture. Horizon Cloud Pod Architecture provides Geo-Affinity using globalentitlements. See "Integrating Cloud Pod Architecture Deployments" in Setting up Resources inVMware Identity Manager for information. No additional changes are required for aVMware Identity Manager multi-datacenter deployment.
 n Horizon View (without Cloud Pod Architecture) - If Horizon Cloud Pod Architecture is notenabled in your environment, you cannot enable Geo-Affinity. After a fail-over event, you canmanually switch VMware Identity Manager to launch Horizon View resources from the View podsconfigured in the secondary data center. See “Configure Failover Order of Horizon View andCitrix-based Resources,” on page 87 for more information.
 n Citrix Resources - Similar to Horizon View (without Cloud Pod Architecture), you cannot enableGeo-Affinity for Citrix resources. After a fail-over event, you can manually switchVMware Identity Manager to launch Citrix resources from the XenFarms configured in thesecondary data center. See “Configure Failover Order of Horizon View and Citrix-basedResources,” on page 87 for more information.
 Setting up a Secondary Data CenterThe secondary data center is typically managed by a different vCenter Server. When you set up thesecondary data center, you can configure and implement the following based on your requirements.
 n VMware Identity Manager appliances in the secondary data center, created from an OVA file importedfrom the primary data center
 n Load balancer for the secondary data center
 n Duplicate Horizon View and Citrix-based resources and entitlements
 n Database configuration
 n Load balancer or DNS entry across the primary and secondary data centers for failover
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Modify the Primary Data Center for ReplicationBefore you set up the secondary data center, configure the primary data center for Elasticsearch, RabbitMQ,and Ehcache replication across clusters.
 Elasticsearch, RabbitMQ, and Ehcache are embedded in the VMware Identity Manager virtual appliance.Elasticsearch is a search and analytics engine used for auditing, reports, and directory sync logs. RabbitMQis a messaging broker. Ehcache provides caching capabilities.
 Configure these changes in all the nodes in the primary data center cluster.
 Prerequisites
 You have set up a VMware Identity Manager cluster in the primary data center.
 Procedure
 1 Configure Elasticsearch for replication.
 Make these changes in each node of the primary data center cluster.
 a Disable the cron job for Elasticsearch.
 1 Edit the /etc/cron.d/hznelasticsearchsync file:
 vi /etc/cron.d/hznelasticsearchsync
 2 Comment out this line:
 #*/1 * * * * root /usr/local/horizon/scripts/elasticsearchnodes.hzn
 b Add the IP addresses of all the nodes in the primary data center cluster.
 1 Edit the /etc/sysconfig/elasticsearch file.
 vi /etc/sysconfig/elasticsearch
 2 Add the IP addresses of all the nodes in the cluster:
 ES_UNICAST_HOSTS=IPaddress1,IPaddress2,IPaddress3
 c Add the load balancer FQDN of the secondary data center cluster tothe /usr/local/horizon/conf/runtime-config.properties file.
 1 Edit the /usr/local/horizon/conf/runtime-config.properties file.
 vi /usr/local/horizon/conf/runtime-config.properties
 2 Add this line to the file:
 analytics.replication.peers=LB_FQDN_of_second_cluster
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2 Configure RabbitMQ for replication.
 Make these changes in each node of the primary data center cluster.
 a Disable the cron job for RabbitMQ.
 1 vi /etc/cron.d/hznrabbitmqsync
 2 Comment out this line:
 #*/1 * * * * root /usr/local/horizon/scripts/rabbitmqnodes.hzn
 b Make the following changes in the /usr/local/horizon/scripts/rabbitmqnodes.hzn file.
 1 vi /usr/local/horizon/scripts/rabbitmqnodes.hzn
 2 Comment out these lines.
 #make sure SAAS is up, otherwise we won't have an accurate node list
 #if test $(curl -X GET -k https://localhost/SAAS/API/1.0/REST/system/health/allOk -
 sL -w "% {http_code}\\n" -o /dev/null) -ne 200 ; then
 # echo SAAS not running, aborting
 # exit 0
 #fi
 Also comment out the following line.
 #nodes=$(uniqList true $(enumeratenodenames))
 3 Add the host names of all the nodes in the primary data center cluster. Use the host namesonly, not the fully qualified domain names. Separate the names with a space.
 nodes="node1 node2 node3"
 c Add the IP address and host name mapping of the other nodes in the cluster to the /etc/hosts file.Do not add an entry for the node you are editing. This step is only required if there is no DNS entrythat can resolve the fully-qualified domain name or partially-qualified domain names.
 IPaddress node2FQDN node2
 IPaddress node3FQDN node3
 d Run the script to build the RabbitMQ cluster.
 /usr/local/horizon/scripts/rabbitmqnodes.hzn
 3 Configure Ehcache for replication.
 Make these changes in each node of the primary data center cluster.
 a vi /usr/local/horizon/conf/runtime-config.properties
 b Add the FQDN of the other nodes in the cluster. Do not add the FQDN of the node you are editing.Separate FQDNs by a colon.
 ehcache.replication.rmi.servers=node2FQDN:node3FQDN
 For example:
 ehcache.replication.rmi.servers=server2.example.com:server3.example.com
 4 Restart the VMware Identity Manager service on all nodes.
 service horizon-workspace restart
 5 Verify that the cluster is set up correctly.
 Run these commands on all the nodes in the first cluster.
 a Verify the health of Elasticsearch.
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curl 'http://localhost:9200/_cluster/health?pretty'
 The command should return a result similar to the following.
 {
 "cluster_name" : "horizon",
 "status" : "green",
 "timed_out" : false,
 "number_of_nodes" : 3,
 "number_of_data_nodes" : 3,
 "active_primary_shards" : 20,
 "active_shards" : 40,
 "relocating_shards" : 0,
 "initializing_shards" : 0,
 "unassigned_shards" : 0,
 "delayed_unassigned_shards" : 0,
 "number_of_pending_tasks" : 0,
 "number_of_in_flight_fetch" : 0
 }
 If there are problems, see “Troubleshooting Elasticsearch and RabbitMQ,” on page 102.
 b Verify the health of RabbitMQ.
 rabbitmqctl cluster_status
 The command should return a result similar to the following.
 Cluster status of node 'rabbitmq@node3' ...
 [{nodes,[{disc,['rabbitmq@node2','rabbitmq@node3']}]},
 {running_nodes,['rabbitmq@node3']},
 {cluster_name,<<"[email protected]">>},
 {partitions,[]},
 {alarms,[{'rabbitmq@node3',[]}]}]
 If there are problems, see “Troubleshooting Elasticsearch and RabbitMQ,” on page 102.
 c Verify that the /opt/vmware/horizon/workspace/logs/ horizon.log file contains this line.
 Added ehcache replication peer: //node3.example.com:40002
 The host names should be those of the other nodes in the cluster.
 What to do next
 Create a cluster in the secondary data center. Create the nodes by exporting the OVA file of the firstVMware Identity Manager virtual appliance from the primary data center cluster and using it to deploy thenew virtual appliances in the secondary data center..
 Create VMware Identity Manager Virtual Appliances in Secondary Data CenterTo set up a VMware Identity Manager cluster in the secondary data center, you export the OVA file of theoriginal VMware Identity Manager appliance in the primary data center and use it to deploy appliances inthe secondary data center.
 Prerequisites
 n VMware Identity Manager OVA file that was exported from the original VMware Identity Managerappliance in the primary data center
 n IP addresses and DNS records for secondary data center
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Procedure
 1 In the primary data center, export the OVA file of the original VMware Identity Manager appliance.
 See the vSphere documentation for information.
 2 In the secondary data center, deploy the VMware Identity Manager OVA file that was exported to createthe new nodes.
 See the vSphere documentation for information. Also see “Install the VMware Identity Manager OVAFile,” on page 19.
 3 After the VMware Identity Manager appliances are powered on, update the appliance configuration foreach.
 The VMware Identity Manager appliances in the secondary data center are identical copies of theoriginal VMware Identity Manager appliance in the primary data center. Syncing to Active Directoryand to resources that are configured in the primary data center is disabled.
 What to do next
 Go to the administration console pages and configure the following:
 n Enable Join Domain as configured in the original VMware Identity Manager appliance in the primarydata center.
 n In the Auth Adapters page, add the authentication methods that are configured in the primary datacenter.
 n In the Directory Authentication Method page, enable Windows Authentication, if configured in theprimary data center.
 Go to the appliance settings Install Certificate page to add Certificate Authority signed certificates,duplicating the certificates in the VMware Identity Manager appliances in the primary data center. See “Using SSL Certificates,” on page 35.
 Configure Nodes in Secondary Data CenterAfter you create nodes in the secondary data center by using the OVA file exported from the primary datacenter, configure the nodes.
 Follow these steps for each node in the secondary data center.
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Procedure
 u Update IP tables.
 a Verify that the /usr/local/horizon/conf/flags/enable.rabbitmq file exists.
 touch /usr/local/horizon/conf/flags/enable.rabbitmq
 b In the /usr/local/horizon/scripts/updateiptables.hzn file, update the IP addresses of all nodesin the secondary data center.
 1 vi /usr/local/horizon/scripts/updateiptables.hzn
 2 Find and replace the ALL_IPS line. Specify the IP addresses delimited by a space.
 ALL_IPS="Node1_IPaddress Node2_IPaddress Node3_IPaddress"
 3 Open ports by running this script.
 /usr/local/horizon/scripts/updateiptables.hzn
 c Configure the nodes for Elasticsearch, RabbitMQ, and Ehcache replication and verify that they areset up correctly.
 See the instructions in “Modify the Primary Data Center for Replication,” on page 83 and applythem to the nodes in the secondary data center.
 Note that the cron jobs are already disabled.
 Edit runtime-config.properties File in Secondary Data CenterIf you are using a database other than a SQL Server Always On deployment, you must edit the runtime-config.properties files for the VMware Identity Manager appliances in the secondary data center to changethe JDBC URL to point to the database in the secondary data center and to configure the appliance for read-only access. If you are using a SQL Server Always On deployment, this step is not required.
 Make these changes in each VMware Identity Manager appliance in the secondary data center.
 Procedure
 1 Using a ssh client, log in to the VMware Identity Manager appliance as the root user.
 2 Open the runtime-config.properties file at /usr/local/horizon/conf/runtime-config.properties.
 3 Change the JDBC URL to point to the database for the secondary data center.
 See “Configure VMware Identity Manager to Use an External Database,” on page 35.
 4 Configure the VMware Identity Manager appliance to have read-only access.
 Add the line read.only.service=true.
 5 Restart the Tomcat server on the appliance.
 service horizon-workspace restart
 Configure Failover Order of Horizon View and Citrix-based ResourcesFor Horizon View and Citrix-based resources, you must configure the failover order of resources in both theprimary and secondary data centers to make the appropriate resources available from any data center.
 You use the hznAdminTool command to create a database table with the failover order for resources in yourorganization per service instance. The configured failover order is followed when a resource is launched.You run the hznAdminTool failoverConfiguration in both data centers to set up the failover order.
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Prerequisites
 When VMware Identity Manager is deployed in multiple data centers, the same resources are also set up ineach data center. Each application or desktop pool in the View Pods or Citrix-based XenFarms is consideredas a different resource in the VMware Identity Manager catalog. To prevent duplication of the resource inthe catalog, make sure that you enabled Do not sync duplicate applications in the View Pools or PublishedApps - Citrix pages in the administration console page.
 Procedure
 1 Using a ssh client, log in to the VMware Identity Manager appliance as the root user.
 2 To view a list of the server instances, type hznAdminTool serviceInstances.
 A list of the service instances with the ID number assigned displays, as in this example.
 {"id":103,"hostName":"ws4.domain.com","ipaddress":"10.142.28.92"}{"id":
 154,"hostName":"ws3.domain.com","ipaddress":"10.142.28.91"}{"id":
 1,"hostName":"ws1.domain.com","ipaddress":"10.143.104.176"}{"id":
 52,"hostName":"ws2.domain.com","ipaddress":"10.143.104.177"}
 3 For each service instance in your organization, configure the failover order for View and Citrix-basedresources.
 Type hznAdminTool failoverConfiguration -configType <configType> -configuration<configuration> -serviceInstanceId <serviceInstanceId> [-orgId <orgId>]
 Option Description
 -configType Type the resource type being configured for failover. Values are eitherVIEW or XENAPP.
 -configuration Type the failover order. For VIEW configType, type as a comma separatedlist of the primary View Connector Server host names that are listed in theView Pools page in the administration console. For XENAPP configType,type as a comma separated list of XenFarm names.
 -serviceInstanceId Type the ID of the service instance for which the configuration is set. TheID can be found in the list displayed in Step 2, "id":
 -orgId (Optional). If left blank, the configuration is set for the defaultorganization.
 For example, hznAdminTool failoverConfiguration -configType VIEW -configurationpod1vcs1.domain.com,pod2vcs1.hs.trcint.com -orgId 1 -serviceInstanceId 1.
 When you type this command for VMware Identity Manager instances in the secondary data center,reverse the order of the View Connection Servers. In this example, the command would behznAdminTool failoverConfiguration -configType VIEW -configuration pod2vcs1.hs.trcint.com,
 pod1vcs1.domain.com -orgId 1 -serviceInstanceId 103
 The resources failover database table is set up for each data center.
 What to do next
 To see the existing failover configuration for each of the View and Citrix-based resources, run hznAdminToolfailoverConfigurationList -configType <configtype> -<orgId).
 The value for <configtype> is either VIEW or XENAPP. The following is an example output of hznAdminToolfailoverConfiguraitonList with configType VIEW.
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{"idOrganization":1,"serviceInstanceId":
 52,"configType":"VIEW","configuration":"pod1vcs1.domain.com,pod2vcs1.domain.com"}
 {"idOrganization":1,"serviceInstanceId":
 103,"configType":"VIEW","configuration":"pod2vcs1.domain.com,pod1vcs1.domain.com"}
 {"idOrganization":1,"serviceInstanceId":
 154,"configType":"VIEW","configuration":"pod2vcs1.domain.com,pod1vcs1.domain.com"}
 Configure Database for FailoverFor VMware Identity Manager, database replication is configured so that data remains consistent acrossdatabase servers within the primary data center and across to the secondary data center.
 You must configure your external database for high availability. Configure a master and slave databasearchitecture, where the slave is an exact replica of the master.
 Refer to your external database documentation for information.
 If you are using SQL Server Always On, use the hostname or IP address of the SQL Server listener when youconfigure the database in each VMware Identity Manager appliance. For example:
 jdbc:sqlserver://<listener_hostname>;DatabaseName=saas
 Failover to Secondary Data CenterWhen the primary data center fails, you can fail over to the secondary data center. To fail over, you need tomodify the global load balancer or DNS record to point to the load balancer in the secondary data center.
 Depending on your database setup, the VMware Identity Manager appliances in the secondary data centerare either in read-only mode or in read-write mode. For all databases except SQL Server Always On, theVMware Identity Manager appliances are in read-only mode. Therefore, most administrator operations, likeadding users or apps, or entitling users, are not available.
 If you are using a SQL Server Always On deployment, the VMware Identity Manager appliances in thesecondary data center are in read-write mode.
 Using a DNS Record to Control Which Data Center is ActiveIf you use a Domain Name System (DNS) record to route user traffic in your data centers, the DNS recordshould point to a load balancer in the primary data center under normal operating situations.
 If the primary data center becomes unavailable, the DNS record should be updated to point to the loadbalancer in the secondary data center.
 When the primary data center becomes available again, the DNS record should be updated to point to theload balancer in primary data center.
 Setting Time To Live in DNS Record
 The time to live (TTL) setting determines how long before DNS related information is refreshed in the cache.For a seamless failover of View desktops and applications, make sure that the time to live (TTL) setting onthe DNS records is short. If the TTL setting is set too long, users might not be able to access their Viewdesktops and applications immediately after failover. To enable quick refresh of the DNS, set the DNS TTLto 30 seconds.
 Chapter 6 Advanced Configuration for the VMware Identity Manager Appliance
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VMware Identity Manager Activities Not Available in Read-Only ModeUsing VMware Identity Manager in read-only mode is designed for high availability to allow end usersaccess to the resources in their My Apps portal. Some activities in the VMware Identity Manageradministration console and other administration services pages might not be available in read-only mode.Below is a partial list of common activities that are not available.
 When VMware Identity Manager is running in read-only mode, activities related to changes in ActiveDirectory or the database cannot be made and syncing to the VMware Identity Manager database does notwork.
 Administrative functions that require writing to the database are not available during this time. You mustwait until VMware Identity Manager returns to read and write mode.
 VMware Identity Manager Administration Console Read-Only Mode
 The following are some of the limitations in the administration console in read-only mode.
 n Adding, deleting, editing users and groups in the Users & Groups tab
 n Adding, deleting, editing applications in the Catalog tab
 n Adding, deleting, editing application entitlements
 n Changing branding information
 n Directory Sync to add, edit, delete users and groups
 n Editing information about resources, including View, XenApp, and other resources
 n Editing the Authentication Methods page
 Note The connector components of the VMware Identity Manager appliances in the secondary data centerappear in the administration console. Make sure that you do not select a connector from the secondary datacenter as the sync connector.
 Virtual Appliance Configuration Pages Read-Only Mode
 The following are some of the limitations in the Appliance Configuration pages in read-only mode
 n Testing the database connection setup
 n Changing the admin password in the Change Password page
 End User Apps Portal Read-Only Mode
 When VMware Identity Manager is in read-only mode, users can sign in to their VMware Identity Managerportal and access their resources. The following functionality in the end user portal is not available in read-only mode.
 n Mark a resource as Favorite or unmark a resource as Favorite
 n Add resources from the Catalog page or remove resources from the Launcher page
 n Change their password from their apps portal page
 VMware Identity Manager Windows Client Read-Only Mode
 When VMware Identity Manager is in read-only mode, users cannot set up new Windows clients. ExistingWindows clients continue to work.
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Failback to Primary Data CenterIn most failure scenarios, you can fail back to the primary data center once that data center is functioningagain.
 Procedure
 1 Modify the global load balancer or the DNS record to point to the load balancer in the primary datacenter.
 See “Using a DNS Record to Control Which Data Center is Active,” on page 89.
 2 Clear the cache in the secondary data center.
 You can use REST APIs to clear the cache.
 PATH: /SAAS/jersey/manager/api/removeAllCaches
 Method: POST
 Roles Allowed: OPERATOR only
 Promoting Secondary Data Center to Primary Data CenterIn case of an extended data center failure, the secondary data center can be promoted to primary.
 For a SQL Server Always On deployment, no changes are required. For other database configurations, youneed to edit the runtime-config.properties file in the VMware Identity Manager appliances in thesecondary data center to configure the appliances for read-write mode.
 Make these changes in each VMware Identity Manager appliance in the secondary data center.
 Procedure
 1 Using a ssh client, log in to the VMware Identity Manager appliance as the root user.
 2 Open the /usr/local/horizon/conf/runtime-config.properties file for editing.
 3 Change the read.only.service=true line to read.only.service=false.
 4 Save the runtime-config.properties file.
 5 Restart the Tomcat server on the appliance.
 service horizon-workspace restart
 Upgrading VMware Identity Manager with No DowntimeWith a multi-data center deployment, you can upgrade VMware Identity Manager to the next version withno downtime. Use this suggested workflow for rolling updates.
 Refer to the diagram in “Deploying VMware Identity Manager in a Secondary Data Center for Failover andRedundancy,” on page 80 as you follow these steps.
 Procedure
 1 Switch routing on the Global LB to send the requests to the DC2 LB.
 2 Stop database replication.
 3 Update the vIDM1 virtual appliance, then update the vIDM2 virtual appliance, and then update thevIDM 3 virtual appliance.
 4 Test updates using DC1-LB.
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5 Once satisfied, switch Global LB to route requests to DC1 LB.
 6 Update the vIDM4 virtual appliance, then update the vIDM5 virtual appliance, and then update thevIDM6 virtual appliance.
 7 Test updates using DC2-LB.
 8 Start database replication.
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Installing Additional ConnectorAppliances 7
 The connector is a part of the VMware Identity Manager service. When you install aVMware Identity Manager virtual appliance, a connector component is always included by default.
 The connector performs the following functions.
 n Syncs user and group data between your enterprise directory and the corresponding directory youcreate in the service.
 n When used as an identity provider, authenticates users to the service.
 The connector is the default identity provider.
 As a connector is already available as part of the service, in typical deployments you do not need to installan additional connector.
 In some scenarios, however, you might need an additional connector. For example:
 n If you have multiple directories of type Active Directory (Integrated Windows Authentication), youneed a separate connector for each.
 A connector instance can be associated with multiple directories. A partition called the worker iscreated in the connector for each directory. However, you cannot have two workers of the IntegratedWindows Authentication type in the same connector instance.
 n If you want to manage users' access based on whether they sign in from an internal or external location.
 n If you want to use certificate-based authentication but your load balancer is configured to terminate SSLat the load balancer. Certificate authentication requires SSL pass-through at the load balancer.
 To install an additional connector, you perform the following tasks.
 n Download the connector OVA package.
 n Generate an activation token in the service.
 n Deploy the connector virtual appliance.
 n Configure connector settings.
 Any additional connectors you deploy appear in the service user interface.
 This chapter includes the following topics:
 n “Generate Activation Code for Connector,” on page 94
 n “Deploy the Connector OVA File,” on page 94
 n “Configure Connector Settings,” on page 95
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Generate Activation Code for ConnectorBefore you deploy the connector virtual appliance, generate an activation code for the new connector fromthe VMware Identity Manager service. The connector activation code is used to establish communicationbetween the service and the connector.
 Procedure
 1 Log in to the VMware Identity Manager administration console.
 2 Click the Identity & Access Management tab.
 3 Click Setup.
 4 In the Connectors page, click Add Connector.
 5 Enter a name for the new connector instance.
 6 Click Generate Activation Code.
 The activation code is displayed in the Connector Activation Code field.
 7 Copy and save the connector activation code.
 You will use the activation code when you run the Connector Setup wizard.
 What to do next
 Install the connector virtual appliance.
 Deploy the Connector OVA FileYou download the connector OVA file and deploy it using the VMware vSphere Client or vSphere WebClient.
 Prerequisites
 n Identify the DNS records and host name to use for your connector OVA deployment.
 n If using the vSphere Web Client, use either Firefox or Chrome browsers. Do not use Internet Explorer todeploy the OVA file.
 n Download the connector OVA file.
 Procedure
 1 In the vSphere Client or the vSphere Web Client, select File > Deploy OVF Template.
 2 In the Deploy OVF Template pages, enter the information specific to your deployment of the connector.
 Page Description
 Source Browse to the OVA package location, or enter a specific URL.
 OVA Template Details Verify that you selected the correct version.
 License Read the End User License Agreement and click Accept.
 Name and Location Enter a name for the virtual appliance. The name must be unique withinthe inventory folder and can contain up to 80 characters. Names are casesensitive.Select a location for the virtual appliance.
 Host / Cluster Select the host or cluster to run the deployed template.
 Resource Pool Select the resource pool.
 Storage Select the location to store the virtual machine files.
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Page Description
 Disk Format Select the disk format for the files. For production environments, select aThick Provision format. Use the Thin Provision format for evaluation andtesting.
 Network Mapping Map the networks in your environment to the networks in the OVFtemplate.
 Properties a In the Timezone setting field, select the correct time zone.b The Customer Experience Improvement Program checkbox is selected
 by default. VMware collects anonymous data about your deploymentin order to improve VMware's response to user requirements. Deselectthe checkbox if you do not want the data collected.
 c In the Host Name text box, enter the host name to use. If this is blank,reverse DNS is used to look up the host name.
 d To configure the static IP address for connector, enter the address foreach of the following: Default Gateway, DNS, IP Address, andNetmask.Important If any of the four address fields, including Host Name,are left blank, DHCP is used.
 To configure DHCP, leave the address fields blank.
 Ready to Complete Review your selections and click Finish. Depending on your network speed, the deployment can take several minutes. You can view theprogress in the progress dialog box.
 3 When the deployment is complete, select the appliance, right-click, and select Power > Power on.
 The appliance is initialized. You can go to the Console tab to see the details. When the virtual applianceinitialization is complete, the console screen displays the version and URLs to log in to the Setup wizardto complete the setup.
 What to do next
 Use the Setup wizard to add the activation code and administrative passwords.
 Configure Connector SettingsAfter the connector OVA is deployed and installed, you run the Setup wizard to activate the appliance andconfigure the administrator passwords.
 Prerequisites
 n You have the activation code for the new connector. See “Generate Activation Code for Connector,” onpage 94.
 n Ensure the connector appliance is powered on and you know the connector URL.
 n Collect a list of passwords to use for the connector administrator, root account, and sshuser account.
 Procedure
 1 To run the Setup wizard, enter the connector URL that was displayed in the Console tab after the OVAwas deployed.
 2 On the Welcome Page, click Continue.
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3 Create strong passwords for the following connector virtual appliance administrator accounts.
 Strong passwords should be at least eight characters long and include uppercase and lowercasecharacters and at least one digit or special character.
 Option Description
 Appliance Administrator Create the appliance administrator password. The user name is admin andcannot be changed. You use this account and password to log into theconnector services to manage certificates, appliance passwords and syslogconfiguration.Important The admin user password must be at least 6 characters inlength.
 Root Account A default VMware root password was used to install the connectorappliance. Create a new root password.
 sshuser Account Create the password to use for remote access to the connector appliance.
 4 Click Continue.
 5 On the Activate Connector page, paste the activation code and click Continue.
 The activation code is verified and the communication between the service and the connector instance isestablished.
 The connector configuration is complete.
 What to do next
 In the service, set up your environment based on your needs. For example, if you added an additionalconnector because you want to sync two Integrated Windows Authentication directories, create thedirectory and associate it with the new connector.
 Configure SSL certificates for the connector. See “Using SSL Certificates,” on page 35.
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Preparing to Use KerberosAuthentication on iOS Devices 8
 When you initially deploy the VMware Identity Manager service, your existing Active Directoryinfrastructure is used for user authentication and management. You integrate the service with otherauthentication solutions such as Kerberos, Certificate, and RSA SecurID from the administration console.For Mobile SSO authentication on AirWatch managed iOS devices, you manually initialize the KeyDistribution Center (KDC) in the appliance before you enable the authentication method from theadministration console.
 Kerberos authentication provides users, who are successfully signed in to their domain, access to their appsportal without additional credential prompts. To support iOS devices using Kerberos,VMware Identity Manager provides the built-in Kerberos authentication method, Mobile SSO for iOS, toaccess the KDC within the built-in identity provider without the use of a connector or a third-party system.
 After you initialize the KDC and restart the service, create public DNS entries to allow the Kerberos clientsto find the KDC.
 To use the Mobile SSO for iOS authentication method, you must configure both AirWatch and the VMwareIdentity Manager service. See the VMware Identity Manager Administration Guide, Implementing Built-inKerberos Authentication for AirWatch-Managed iOS Devices.
 This chapter includes the following topics:
 n “Pre- KDC Configuration Decisions,” on page 97
 n “Initialize the Key Distribution Center in the Appliance,” on page 98
 n “Creating Public DNS Entries for KDC with Built-In Kerberos,” on page 99
 Pre- KDC Configuration DecisionsBefore you initialize KDC in VMware Identity Manager, determine the realm name for the KDC server;whether subdomains are in your deployment, and whether to use default KDC server certificate or not.
 RealmThe realm is the name of an administrative entity that maintains authentication data. Selecting a descriptivename for the Kerberos authentication realm is important. The realm name must be a part of a DNS domainthat the enterprise can configure.
 The realm name and the fully qualified domain name (FQDN) that is used to access the VMware IdentityManager service are independent. Your enterprise must control the DNS domains for both the realm nameand the FQDN. The convention is to make the realm name the same as your domain name, entered inuppercase letters. Sometimes the realm name and domain are different. For example, a realm name isEXAMPLE.NET, and idm.example.com is the VMware Identity Manager FQDN. In this case, you define DNSentries for both example.net and example.com domains.
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The realm name is used by a Kerberos client to generate DNS names. For example, when the name isexample.com, the Kerberos related name to contact the KDC by TCP is _kerberos._tcp.EXAMPLE.COM.
 Using SubdomainsThe VMware Identity Manager service installed in an on-premises environment can use the VMwareIdentity Manager FQDN subdomain. If your VMware Identity Manager site accesses multiple DNSdomains, configure the domains as location1.example.com; location2.example.com; location3.example.com.The subdomain value in this case is example.com, typed in lower case. To configure a subdomain in yourenvironment work with your service support team.
 Using KDC Server CertificatesWhen the KDC is initialized, by default a KDC server certificate and a self-signed root certificate aregenerated. The certificate is used to issue the KDC server certificate. This root certificate is included in thedevice profile so that the device can trust the KDC.
 You can manually generate the KDC server certificate using an enterprise root or intermediate certificate.Contact your service support team for more details about this feature.
 You download the KDC server root certificate from the VMware Identity Manager admin console to use inthe AirWatch configuration of the iOS device management profile.
 Initialize the Key Distribution Center in the ApplianceBefore you can use the Mobile SSO for iOS authentication method, you must initialize the Key DistributionCenter (KDC) in the VMware Identity Manager appliance.
 To initialize KDC, you assign your identity manager hostname to the Kerberos realms. The domain name isentered in upper-case letters. If you are configuring multiple Kerberos realms, to help identify the realm, usedescriptive names that end with your identity manager domain name. For example, SALES.MY-IDENTITYMANAGER.EXAMPLE.COM. If you configure subdomains, type the subdomain name in lower-case letters.
 Prerequisites
 VMware Identity Manager is installed and configured.
 Realm name identified. See “Pre- KDC Configuration Decisions,” on page 97.
 Procedure
 1 SSH into the VMware Identity Manager appliance as the root user.
 2 Initialize the KDC. Enter /etc/init.d/vmware-kdc init --realm {REALM.COM} --subdomain {sva-name.subdomain}.
 For example, /etc/init.d/vmware-kdc init --realm MY-IDM.EXAMPLE.COM --subdomain my-idm.example.com
 If you are using a load balancer with multiple identity manager appliances, use the name of the loadbalancer in both cases.
 3 Restart the VMWare Identity Manager service. Enter service horizon-workspace restart.
 4 Start the KDC service. Enter service vmware-kdc restart.
 What to do next
 Create public DNS entries. DNS records must be provisioned to allow the clients to find the KDC. See “Creating Public DNS Entries for KDC with Built-In Kerberos,” on page 99.
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Creating Public DNS Entries for KDC with Built-In KerberosAfter you initialize KDC in VMware Identity Manager, you must create public DNS records to allow theKerberos clients to find the KDC when the built-in Kerberos authentication feature is enabled.
 The KDC realm name is used as part of the DNS name for the VMware Identity Manager appliance entriesthat are used to discover the KDC service. One SRV DNS record is required for each VMware IdentityManager site and two A address entries.
 Note The AAAA entry value is an IPv6 address that encodes an IPv4 address. If the KDC is notaddressable via IPv6 and an IPv4 address is used, the AAAA entry might have to be specified in a strict IPv6notation as ::ffff:175c:e147 on the DNS server. You can use an IPv4 to IPv6 conversion tool, such as oneavailable from Neustar.UltraTools, to convert IPv4 to IPv6 address notation.
 Example: DNS Record Entries for KDCIn this example DNS record, the realm is EXAMPLE.COM; the VMware Identity Manager fully qualified domainname is idm.example.com, and the VMware Identity Manager IP address 1.2.3.4.
 idm.example.com. 1800 IN AAAA ::ffff:1.2.3.4
 idm.example.com. 1800 IN A 1.2.3.4
 _kerberos._tcp.EXAMPLE.COM IN SRV 10 0 88 idm.example.com.
 _kerberos._udp.EXAMPLE.COM IN SRV 10 0 88 idm.example.com.
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Troubleshooting Installation andConfiguration 9
 The troubleshooting topics describe solutions to potential problems you might encounter when installing orconfiguring VMware Identity Manager.
 This chapter includes the following topics:
 n “Users Unable to Launch Applications or Incorrect Authentication Method Applied in Load-BalancedEnvironments,” on page 101
 n “Group Does Not Display Any Members after Directory Sync,” on page 102
 n “Troubleshooting Elasticsearch and RabbitMQ,” on page 102
 Users Unable to Launch Applications or Incorrect AuthenticationMethod Applied in Load-Balanced Environments
 Users are unable to launch applications from the Workspace ONE portal or the wrong authenticationmethod is applied in a load-balanced environment.
 Problem
 In a load-balanced environment, problems such as the following might occur:
 n Users are unable to launch applications from the Workspace ONE portal after they log in.
 n The wrong authentication method is presented to users for step-up authentication.
 Cause
 These problems can occur if access policies are determined incorrectly. The client IP address determineswhich access policy is applied during login and during application launch. In a load-balanced environment,VMware Identity Manager uses the X-Forwarded-For header to determine the client IP address. In somecases, an error might occur.
 Solution
 Set the service.numberOfLoadBalancers property in the runtime-config.properties file in each of the nodesin your VMware Identity Manager cluster. The property specifies the number of load balancers fronting theVMware Identity Manager instances.
 Note Setting this property is optional.
 1 Log in to the VMware Identity Manager appliance.
 2 Edit the /usr/local/horizon/conf/runtime-config.properties file and add the following property:
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service.numberOfLoadBalancers numberOfLBs
 where numberOfLBs is the number of load balancers fronting the VMware Identity Manager instances.
 3 Restart the workspace appliance.
 service horizon-workspace restart
 Group Does Not Display Any Members after Directory SyncDirectory sync completes successfully but no users are displayed in synced groups.
 Problem
 After a directory is synced, either manually or automatically based on the sync schedule, the sync processcompletes successfully but no users are displayed in synced groups.
 Cause
 This problem occurs when you have two or more nodes in a cluster and there is a time difference of morethan 5 seconds between the nodes.
 Solution
 1 Ensure that there is no time difference between the nodes. Use the same NTP server across all nodes inthe cluster to synchronize the time.
 2 Restart the service on all the nodes.
 service horizon-workspace restart
 3 (Optional) In the administration console, delete the group, add it again in the sync settings, and syncthe directory again.
 Troubleshooting Elasticsearch and RabbitMQUse this information to troubleshoot problems with Elasticsearch and RabbitMQ in a cluster environment.Elasticsearch, a search and analytics engine used for auditing, reports, and directory sync logs, andRabbitMQ, a messaging broker, are embedded in the VMware Identity Manager virtual appliance.
 Troubleshooting ElasticsearchYou can verify the health of Elasticsearch by using the following command in the VMware Identity Managerappliance.
 curl 'http://localhost:9200/_cluster/health?pretty'
 The command should return a result similar to the following.
 {
 "cluster_name" : "horizon",
 "status" : "green",
 "timed_out" : false,
 "number_of_nodes" : 3,
 "number_of_data_nodes" : 3,
 "active_primary_shards" : 20,
 "active_shards" : 40,
 "relocating_shards" : 0,
 "initializing_shards" : 0,
 "unassigned_shards" : 0,
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"delayed_unassigned_shards" : 0,
 "number_of_pending_tasks" : 0,
 "number_of_in_flight_fetch" : 0
 }
 If Elasticsearch does not start correctly or its status is red, follow these steps to troubleshoot.
 1 Ensure port 9300 is open.
 a Update node details by adding the IP addresses of all nodes in the cluster tothe /usr/local/horizon/scripts/updateiptables.hzn file:
 ALL_IPS="node1IPadd node2IPadd node3IPadd"
 b Run the following script on all nodes in the cluster.
 /usr/local/horizon/scripts/updateiptables.hzn
 2 Restart Elasticsearch on all nodes in the cluster.
 service elasticsearch restart
 3 Check logs for more details.
 cd /opt/vmware/elasticsearch/logs
 tail -f horizon.log
 Troubleshooting RabbitMQYou can verify the health of RabbitMQ by using the following command in the VMware Identity Managerappliance.
 rabbitmqctl cluster_status
 The command should return a result similar to the following.
 Cluster status of node 'rabbitmq@node3' ...
 [{nodes,[{disc,['rabbitmq@node2','rabbitmq@node3']}]},
 {running_nodes,['rabbitmq@node3']},
 {cluster_name,<<"[email protected]">>},
 {partitions,[]},
 {alarms,[{'rabbitmq@node3',[]}]}]
 If RabbitMQ does not start or the health URL https://hostname/SAAS/API/1.0/REST/system/health/ shows"MessagingConnectionOk":"false", follow these steps to troubleshoot.
 1 Ensure ports 4369, 5700, 25672 are open. To open ports:
 a Create the file by using this command:
 touch /usr/local/horizon/conf/flags/enable.rabbitmq
 b Run the following script:
 /usr/local/horizon/scripts/updateiptables.hzn
 2 Restart RabbitMQ.
 a Kill any existing rabbitmq processes.
 b rabbitmqctl stop
 c rabbitmq-server -detached
 3 You may need to restart the VMware Identity Manager service if RabbitMQ does not start gracefully.
 service horizon-workspace restart
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